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1. Introduction to Computers 

The word “Computer” has been derived from the word “compute” which means “to calculate”. In 

the beginning the name ‘computer’ was given to a machine which was used to carry out arithmetical 

calculations at a tremendous speed. Soon it was discovered that this machine could be used to carry 

out a large number of non-mathematical functions such as preparation of result of a very large 

number of candidates, reservations on railways or airlines etc. A computer is defined in anyone of 

the following ways.  

Def: A computer is an automatic electronic machine used for carrying out calculations in numerical 

or logical terms at a tremendous speed.  

Def: - A Computer is a device, which under the direction of a program, can process data, after its 

own program instructions, and performed computation and logical operations without human 

intervention.  

Def: - A computer is an electronic machine, which accepts raw information (data) as input and 

reveals useful information as output.  

Def: - Computer is an electronic data processing device that automatically: 

1. Accept and store input data. 

2. Process the same and, 

3. Output the processed results in the form required by the user.  

In fact, a computer is a complete system in itself. The computer as a system is, in fact, a combination 

of hardware and software components that jointly offer the necessary services to the user.  

1.2. Characteristics of Computer 

The various characteristics of computers are given below.  

1. Speed: - A Computer is a very high speed device. They can perform or execute more than 

hundred million instructions per second, thus resulting in a very high speed performance.  

2. Accuracy: - The accuracy of a computer is consistently high and the degree of accuracy of a 

particular depends upon its design. But for a particular computer, each and every calculation is 

performed with the same accuracy. Errors can occur in a computer, but these are mainly due to 

human rather than technological weaknesses, that is, due to imprecise thinking by the 

programmer or due to inaccurate data. 

3. Diligence: - (no fatigue) – A human being gets bored and tired and loses efficiency and 

accuracy in repetitive tasks but a computer never gets bored or tired. It will perform a 

calculation with the same speed and same accuracy for any number of times.  

4. Storage: - The high speed of calculation, of computers result into requirement of more and 

more internal memory. The storage capacity of present day computer has entered into 
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megabyte and gigabyte. A good computer supports a few hundred megabyte to some gigabyte 

of RAM.  

5. Versatility:- A computer is a versatile machine. It can be used to solve the problems related to 

different filled. At one moment, it may be solving a complex scientific problem and the very 

next moment it may be playing a game and then is busy in taking up a database problem.  

6. Reliability:- The computers are reliable, very accurate and do not make mistakes in arithmetic 

calculations. The reason behind this is that at hardware level, it does not require human 

intervention between its processing operations. Moreover the computers contain built in 

diagnostic capabilities which help in continuous monitoring of the system.  

7. Reduction in paper work:-  The use of computers for data processing has helped the 

management of business organization to cope (manage) with the increasing problems of paper 

handling by elimination some of paper needs through the storage of data in data bases and files 

from where they can be retrieved when needed.  

8. Reduction in Cost:- The initial investment for installing a computer is high but it substantially     

(considerably) reduces the cost of its operation thereafter.  

9. Retrieval Capacity:- A computer has not only a high storage capacity rather it can retrieve the 

data or knowledge stored there in seconds with high accuracy. It can store and recall any 

amount of information from its main memory or from secondary storage or both.  

10. Increased ability to perform computations:- The use of computer helped in performing 

computations with speed.  

11. Data Base:- The use of computer facility in business organization facilities establishment of 

database.  Data base integrates data records and reduces data redundancy.   

12. Facilitates Report Preparation:- Data maintained with the help of a computer facilitates the 

preparation of  various type of reports required by organizational executives for the purpose of  

decision making and control.  

13. Reduce the Space Requirements:- The use of computer for office activities reduces the 

requirements of office space which otherwise is required.  

14. Reduce the manpower requirement:- The number of persons required for performing various 

organizational activities will be reduced by using a computer system.  

15. Intangible (indefinable) benefits: - It includes, customer image, leadership in the industry and 

community, increased customer morale (confidence) and management confidence.  
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1.3 Classification of Computers 

Computers can be classified in various ways. The different classes of computers are as follows:-  

1. By Functional Criteria ( by data representation) 

The computers are divided into three major categories based on functional criterias, as shown 

in given figure. These are: 

❖ Digital Computers 

❖ Analog Computers  

❖ Hybrid Computers 

   

 

 

 

         

 

 

                            Classification by Functional Criteria 

❖ Digital Computer: - Digital Computers take input in the form of numbers, letters and special 

characters, store it and process it and give the output in the form of numbers, letters and special 

characters. Digital computes have the capabilities of adding, subtracting, multiplying, dividing 

and comparing. These computers provide highly accurate result. The examples of digital 

computers are: - Desk calculators, Digital calculator and electronic computers. 

 

❖ Analog Computer: - Analog Computers do not operate on digital data. Instead they operate on 

data presented to them in the form of continuously variable quantities like temperature, pressure, 

revolutions and the like. They react in a predefined way to changes in the specified quantities. 

Analog computer is faster than the digital computer but can give an accuracy of not more than 

99%. These computers are suitable for use as controlling devices in factories, military weaponry, 

aerospace systems and the like. The examples of analog computers are: - speedometer, 

voltmeters, pressure gauges, wall clock.  

 

❖ Hybrid Computer: - Hybrid computers combine the features (capabilities) of both the digital 

and analog computers. They are suitable where digital processing is necessary in respect of data 

collected in the analog form. Both analog and hybrid are special purpose computers. For 

example, in a hospital intensive care unit (I.C.U) analog devices may measure a patient’s heart 

Computers 

Digital Analog Hybrid 
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function, temperature and other vital signs. These measurements may then be converted into 

number and supplied to a digital device which may send an immediate signal to nurses’ station if 

any abnormal readings are detected.  

1.1 Difference between Analog and Digital Computer 

Analog Computer Digital Computer 

1. Analog computer accepts the data and in 

continuous form.  

 

2. Less Accurate (-1%). 

 

3. Speed is high.  

 

4. Represents data as physical quantities.  

 

5. Precision (exactness) is limited in case of 

analog computer.  

 

6. Analog computer measures & answer        

“How much”. 
 

7. It is a special purpose type computer.  

 

8. Output is continuous; time is wasted in 

transition (conversion) time. 

 

9. It performs calculations as physical 

analogies.  

 

10. Example- speedometer, wall clock, 

voltmeter, pressure gauges.  

 

1. Digital computer accepts data in discrete 

form. 

 

2. More accurate (accuracy infinite). 

 

3. Speed is less. 

 

4. Represents data as numbers.  

 

5. Precision is high in digital computers.  

 

 

6. Digital computers counts & answer “How 

many”. 
 

7. It is general purpose type computer.  

 

8. Output is obtained after complete 

computation is carried out.  

 

9. It performs calculations as numbers and 

operates on them mathematically. 

 

10. Example- electronic computers, desk 

calculators.  

 

 

2. Classification of computer according to purpose.  

The computers are classified into two categories according to purpose. These are (i) Special 

Purpose (ii) General Purpose.  

 

❖ Special Purpose Computers: - These types of computers are designed to handle some 

particular type of tasks. The sequences of instructions performed by these computers are 

encoded permanently in some order on the circuit. The 5E89 Computer (“Kurs-1”) is a mobile 

specialized machine using alloy transistors and point contact diodes. It was used for secondary 

processing of real time data from radars in automated control system.  
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❖ General Purpose Computers: - A general purpose computes can do everything that every 

other computer can do or a general purpose computer is designed to perform or is capable of 

performing. In a reasonably efficient manner, the functions required by both scientific and 

business applications. They are plentiful (abundant) and cheap so people use them any way.  

2.1 Difference between Special Purpose & General Purpose Computers  

Special Purpose Computer General Purpose Computer 

1. There are designed to handle a particular 

task.  

 

2. The sequence of instructions is encoded 

permanently on the circuit.  

 

3. They can measure reaction times reliably. 

 

4. Example- Navigational computers used in 

aircraft.  

 

1. These are designed to handle various general 

tasks.  

 

2. The instructions are not permanently 

circuited.  

 

3. They cannot measure reaction times reliably. 

 

4. Example- Computers used for data processing 

like IBM-360.  

3. Classification of computer according to use 

The computers are classified into two categories according use. These are (i) Scientific Computers 

(ii) Business Computers. The major differences between the two are as follows.  

Scientific Computer Business Computer 

1. Fast internal processing speed. 

 

2. Slow input / output devices.  

 

3. Suitable for mathematical applications 

(solution of equations, design of aircraft 

engine, bridges, buildings etc.)  

 

1. Relatively slow in processing.  

 

2. Fast input / output devices.  

 

3. Suitable for jobs involving large inputs / 

outputs and few simple calculations (sample 

survey data, censes data, insurance billing 

payroll etc.)  

 

4. Computer classification on the basis of speed and memory. The computers are classified in 

four categories on the basis on speed and memory. As shown in given figure.  

 

 

 

 

 

 

 

               Classification on the basis of Speed & Memory 

Computers 

Micro  Mini
Main 

frame 
Super
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(A) Micro Computer 

These computers are also known as personal computers (PC). The characteristics of these 

computers are as follows: 

1. They use very little power. They need very less air – conditioning.  

2. The smallest category of a computer, consisting of a microprocessor, storage and input / output 

elements is known as micro computer.  

3. These systems are characterized by their main memory size that ranges from 256 KB to 8 MB. 

Their word length is 8 or 16 or 32 bits.  

4. Maximum speed of micro computers is up to 1 million bytes per second.  

5. They are stable and reliable. Once tested and proved, they can work for years without any hitch 

(delay).  

6. They are generally single user. They can support up to a maximum of 2-3 terminals, when we 

make them multiuser.  

(B) Mini Computer 

The characteristics of mini computers are as follows: 

1. These are more powerful than a micro computer. 

2. They usually employ microprocessors, both of data storage as well as data manipulation.  

3. They are designed to serve multiple users simultaneously.  

4. They can support up to a maximum of 20 terminals.  

5. They can accept and transfer data from I/O devices at the maximum speed of one million bytes  

     per second. 

6. They use Winchester hard disk drives of 80 MB or more, 1 or 2 floppy drives.  

7. Mini computers achieve faster processing speed by employing high speed buffer (safeguard).  

8. These systems are characterized by their main memory size that ranges from 512 MB and 1  

     GB. Their word length is 16 or 32 or 64 bits.                                                        

9. They are more expensive than micro computers.  

10. These are popular among research and business organization.  

Examples: - Digital PDP (Programmed Data Processor) 11, Honey well, HCL II. 

(C) Main Frame Computer 

The characteristics of main frame computers are as follows: 

1. They can accept & transfer data from I/O devices at the rate of several millions bytes per 

second.  

2. They can support a large number of dumb (a dumb terminal is simply an output device that 

accepts data from the CPU) terminals say up to 100 or more.  

3. They can accept all types of high level languages like C, C++, Java, C# etc.  

4. They are larger and expensive as compared to micro and mini computers. 

5. These are big computes capable of handling all kinds of applications whether scientific or 

commercial.  
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6. They support high speed cache memory that enables them to process applications faster than 

other computers. These computers are usually used in large business environments. They are 

mainly used for:  

o Railway and airline reservations. 

o Banking applications.  

o Commercial application of large companies like insurance and hospitals.  

     Examples:- IBM 360, IBM 370, ICL 1900, DEC 10 etc.  

(D) Super Computer  

Super Computer is the biggest and fastest computer, which is mainly designed for complex 

scientific applications. It has many CPUs (Central Processing Units) which operate in 

parallel to make it as a fastest computer. It is typically used for following applications: 

o Weather information  

o Petroleum exploration and production 

o Energy management 

o Defence  

o Nuclear Energy Research  

o Structural Analysis 

o Electronic Design 

o Real time animation  

o Medicine  

Some of the examples of super computers are CRAY3, CRAY-XMP-14, NEC-500, IBM 

3090, PARAM 9000 & PARAM 10000.  

1.4 Applications of Computer 

Computers have lot of applications in each & every sphere in life. Now a day, computers 

have become a blessing for humans. Even, no field of life is untouched by computer. Some 

important applications of computer are as follows: 

 

1.4.1 Application of Computers in office 

▪ In offices, computers are used: 

▪ In preparations of letters & reports.  

▪ To keep record of employees.  

▪ For publicity & administrative work. 

▪ For advertisement. 

▪ To handle correspondence & office communication. 

▪ To prepare & store files.  

▪ In accounting, billing, preparation of pay roles etc.  

▪ In data analysis.   
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1.4.2 Applications of computers in Education 

Computers can be seen everywhere in educational institutions. These can be seen in classroom, 

laboratories, libraries, museums etc. Computers have lot of applications in education, few of 

which are as follows: 

▪ Computers help the students in preparing their presentations, project reports & even the notes.  

▪ Computer can repeat the material of the presentation as many times as desired.  

▪ Computer graphics helps the students to visualized three – dimensional figures & graphs from 

different angles to understand the concepts in a better way. Pictures can move, rotate or 

computer can even speak.  

▪ In libraries, student can enter the name of book that he wants to read & the contents of book 

appear on screen. Now a day, concept of paperless libraries comes into existence.  

▪ In maximum, computers help in giving information by telling about the exhibits. 

▪ In educational institutions, computers are also used by teacher for teaching testing to make the 

students understand in a better way according to their mental level and caliber.  

1.4.3 Applications of computers in Medicines 

In medical field, computers have lot of applications few of which are as follows: 

▪ For diagnosis of illness of patient.  

▪ For performing surgeries.  

▪ For getting information of treatments and latest drugs.  

▪ To keep record of patients.  

▪ In ultrasounds, Magnetic Resonance Imaging (MRI), CT Scan etc.  

▪ To perform pathological tests.  

▪ To replace defective organs inside the body.  

▪ To take internal photographs of human body without even putting a cut on human body.  

▪ Pacemaker is also a form of computer.  

▪ To check patient’s signs for abnormality.  

1.4.4 Applications of computers in Banks  

▪ Computers are used in banks to 

▪ Make entry in passbooks.  

▪ To make withdrawals & deposits.  

▪ Issue fixed deposit receipts.   

▪ To provide online service to its customers.  

▪ To maintain ledger & handle transactions.  

▪ To take out money from ATM (Automated Teller Machine). 

1.4.5 Applications of computers for ticket reservation at railway stations and airlines 

▪ Computer gives all necessary information regarding ticket reservation i.e., train or flight 

numbers, route, distance, number of seats available in each class, fare etc.  

▪ It also gives information regarding name of passengers, their age, destination, date of journey 

etc.  
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▪ Also provide information about the seats in hotels in fare away areas & their climate for the 

convenience of travelers.  

1.4.6 Applications of computers in Science 

▪ Without help of computers, scientists cannot provide any information about our solar system.  

▪ Scientists can predict volcanoes, earthquakes, hurricanes etc., & warn people so that safety 

measures can be provided well in time.  

▪ For weather forecasting.  

▪ For remote sensing.  

▪ Computer monitors the activities of astronauts through satellites. Recently, Chandrayan -1, 

stepped on moon & scientists are watching all the activities through satellites with the help of 

computers.  

1.4.7 Applications of computers at Home 

▪ At home, computer is useful for a kid to very senior or old people – kids can play games or 

do their homework. Monthly budget can be prepared by elders of the family. Addresses of 

relatives can be recorded well.  

▪ All home appliances i.e., microwave oven, washing machine etc., all uses computers for 

running more efficiently. 

▪ At homes, mothers can find out recipes for their kids. 

▪ One can listen music or can watch movies on computes at homes.  

1.4.8 Applications of computers in Defence 

▪ Computers are used in one way or the other in fighter planes, airplanes, on the battlefields in 

weapons.  

▪ Used in submarines by navel academies. 

▪ Used to communicate by radio in air, under water and on land with computer networks.  

▪ Now-a-days, computers are also used as smart bombs which are actually missiles but don’t 
looks like that.  

1.4.9 Applications of computers for data analysis  

▪ A special software called spreadsheet program is developed for data analysis with the help of 

which one can tabulate result, calculate the number of students, their percentage, their result, 

list of failed students & average marks etc.  

▪ A particular organization can prepare about its sale, profit, production, price etc.  

▪ Spreadsheet programs are also used for inventory control, accounts, sale analysis, preparation 

of budgets, business aspects etc.  

1.4.10 Applications of computers in graphics 

▪ Computers are used to draw pictures & drawing that are otherwise difficult to draw. 

▪ Bar graphs, line graphs & pie graphs can be drawn easily. 

▪ Now-a-days, several animated films like Jurassic Park, Jai Hanuman, Bal Ganesha, Road side 

Romeo etc., are prepared with the help of graphics. 

▪ In theatres, total lighting system, effects of light & sounds etc., are done by computer 

graphics. 
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1.4.11 Applications of computers in Music 

▪ Musicians can compose their tunes and music on computer. 

▪ Musicians can translate the music in next form or musical forms using computer.  

▪ To obtain fine editing of music, musicians use different hardware & software in 

synchronization. 

1.4.12 Applications of computers in Manufacturing  

▪ In textile industry, computers are used in cutting fabric, stitching buttons, to design all 

embroidery (sewing), color selection etc. 

▪ In steel industry, computers do work like welding, cutting, painting etc.  

▪ Computers control power production for electricity generating machines.  

▪ In nuclear industry, temp and pressure inside and outside the boilers can be regulated by 

computers.  

▪ For control, planning and manufacturing, computes are used in one way or the other.  

1.4.13 Applications of computers in communication 

▪ Computers are used in sending & receiving information through e-mails. 

▪ Internet, a form of communication, is an ocean of information.  

▪ Computer, modem and a data communication package together are used for communication 

purposes by telephone department. 

▪ Teleconferencing or Videoconferencing allows persons sitting at different places to 

participate in a conference.  

▪ Satellite communication is also involve use of computers at its transmitting station on the 

earth to accept and return the signals. 

1.4.14 Applications of computers in Books Publication 

▪ Publishers use computer in different ways e.g. for processing of text, the correction of text 

referred proof readers. Sketches, diagrams & illustration can be easily made. To add pictures, 

adjust the position of picture, to change the style & size of headlines, computers are used.  

1.4.15 Applications of computers in Artificial Intelligence  

▪ A machine with reasoning, learning and logic capability is said to possess artificial 

intelligence. An artificial intelligence system has a knowledge base and programming 

technique to probe (survey, query, search) and process the facts in the knowledge base. A 

expert system is a software that utilize a knowledge base to make decision in a certain area. 

MYCIN (Mycin was an backward chaining expert system that used artificial intelligence to 

indentify bacteria causing severe infections) is one such software that helps in diagnosing the 

blood diseases and their remedies (cure).    

1.5 Basic Components of Computer (PC) 

There are three components of computer: 

1. Input unit 

2. Central Processing unit 

(a) Memory (b) ALU-(Arithmetic & Logic unit) (c) Control Unit 

3. Output Unit 
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General arrangement of various units is shown in figure 

 

 

 

  

 

 

 

 

 

  

 

 

 

 

 

 

     

 

Flow of data and instructions (data signal) 

Control signal 

(Model of a Digital Computer) 

 

1. Input unit: - This unit contains devices with the help of which we enter data into computer. 

This unit is link between user and computer. Input devices translate the human being 

information into the form understandable by computer.  

The input, output and storage devices are described as online, when they are directly 

connected to CPU, when not corrected directly they are described as offline. Examples of 

input devices:- Keyboard, Mouse, Light Pen, Scanner, Joystick, Voice recognizer, Card 

reader, Digitizer, Floppy drive, Disk drive, Tape drive, OCR (Optical Character Reader), 

OMR( Optical Mark Reader) etc.  

2. Output unit: - Output unit consists of drives with the help of which we get the information 

form computer. Output unit is a link between computer and users. Output devices translate 

the computer’s output into the form understandable by users.  

Examples of output devices: - VDU (Visual Display Unit), Line printer, Dot matrix printer, 

Color graphic terminal, Graph plotter etc.   

 

Control Unit 

ALU 

Memory Unit Output Unit Input Unit 

Secondary Storage Unit 

Or 

Auxiliary Storage Unit 

Or 

Mass Storage Unit 
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3. ALU (Arithmetic & Logic Unit):- This unit consists of two subsections namely:          (i) 

Arithmetic Section. (ii) Logic Section.  

i. Function of Arithmetic section is to perform arithmetic operations like addition, 

subtraction, multiplication & division. All complex operations are done by making 

repetitive use of above operations.  

ii. Function of Logic section is to perform logic operations such as comparing, selecting, 

matching & merging of data.  

 

4. Control Unit: - Control unit controls the operations of all parts of computer. It does not 

carry out any actual data processing operations.  

Functions of this unit are:-  

➢ It retrieves instructions from the main memory and determines what is to be taken.  

➢ It then retrieves the data required to be processed from the main memory.  

➢ It causes the CPU to actually carry out required operations and determines whether 

the required operations have been carried out or not.  

➢ It places the processed results in the output area of the memory.  

➢ It fetches (to bring, to get) the next instruction from the memory and repeat the whole 

cycle of operations outlined above.  

In addition to the above, the control unit also oversees to ensure that erroneous data does not 

enter into the system. When such an event occurs, the control unit displays an error on the 

screen of the CPU to warn computer operator.  

5. Memory or Storage Unit: - This unit can store instruction, data and intermediate results. 

This unit supplies information to the other units of the computer when needed. It is also 

known as internal storage unit or main memory or primary storage or random access memory 

(RAM). Its size affects speed, power and capability. The main memory can be divided into 

four areas that have no fixed or built in physical boundaries within the memory. These areas 

are: (i) Input storage area (ii) working storage area (iii) output storage area (iv) program 

storage area.  

 

Main Memory 

Program Storage Working Storage 

 

Input Storage Output Storage 

 

 

1.6  Hardware and Software 

1.6.1 Hardware 

Def: - The physical components of a computer are called hardware. 
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Def: - Hardware refers to all the physical entries of the machine which can be touched or seen 

with the eye e.g. Keyboard, Monitor, Mouse and CPU etc.  

It helps to run the software. The hardware configuration shows capabilities and limitations of any 

computer system. On the basis of hardware, computers are categorized into Mini, Micro and Main 

Frame etc. The hardware configuration further tells about the various instructions that will be carried 

out per second and with what accuracy and speed. The knowledge of hardware components like 

microprocessor, chip size, other control units, size of the memory etc. helps to know the nature of 

the computer that we are going to use. The components of the hardware mainly include processing 

unit, Memory Unit, control unit, input and output unit.  

1.6.2 Software 

Def: - A set of programs to be fed (feed) into the computer to achieve the desired results is 

called software.  

 

Def: - Software is a set of computer programs which are designed to develop to perform 

specific task desired by the user or by the computer itself. So software makes the computer to 

do work. There are two types of Software.  

o System Software 

o Application Software 

 

1.6.2.1 System Software 

The system software is a collection of programs designed to manage and control the computer 

system. System softwares are generally provided by computer manufactures. These softwares 

perform a variety of functions like memory management, resource accounting, I/O 

management, file management etc. The system software is responsible for the proper 

functioning of the application software on a system. There are several types of system 

software, such as operating systems, and utility programs.  

 

1.6.2.2 Application Software 

Application software is the program or set of programs use to perform various tasks. All 

programs prepared by user and for the user come under the category of application software. 

Examples of application software are payroll software, for the user, inventory control software, 

railway reservation software, word processors, (Word star, Word perfect), spreadsheets (MS 

Excel, Lotus 123).  The application software is enable to run without the system software.  

 

1.6.3 Difference between Application software and System software 

 

Application Software System Software 

1. There are interactive in nature. 

 

2. These are easy to manipulate.  

1. There are less interactive in nature.  

 

2. These are difficult to manipulate. 
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3. These are easy to understand.  

 

4. It is user oriented software.  

 

5. Execution speed is slow. 

 

6. These are general written in high level 

language.  

 

7. Examples are :- Payroll System, Railway 

reservation system, Spreadsheets etc.  

 

3. These are difficult to understand. 

 

4. It is system oriented software. 

 

5. Execution speed is fast. 

 

6. These are general written in low level 

language. 

 

7. Examples are: - operation system, 

compiler, loader, linker etc.  

 

 

1.6.4 Comparison of Hardware & Software 

There are many differences between hardware and software. The major differences are as 

follows: 

 

Hardware Software 

1. The physical components of a computer are 

called hardware e.g. keyboard, mouse, 

CPU & monitor. 

 

2. These are the physical entries which can be 

touched with hands or seen with the eyes.  

3. It helps to run the software. 

 

4. Hardware determines the type of 

computer i.e. mini, micro, mainframe 

and super computer. 

 

1. A set of programs that are fed into the 

computer to get the desired results is 

called software e.g. operating system.  

 

2. Software cannot be touched with the 

hands of seen with the eyes.  

3. Without software, hardware is noting.  

 

4. Softwares are of two types – System 

software & Application software.  

 

1.7 Computer Input & Output Devices (Computer Peripheral Devices) 

 

Introduction 

Input and output devices are the peripheral devices that are attached to the Central Processing Unit 

(CPU). These devices act as a communication between a man and a machine because they provide to 

put every type of data inside the computer and provide the result of various operations performed on 

computer. These devices are so essential to be attached with the computer that without either device, 

we can no accomplish our operations completely.  

1.7.1 Input devices   

The word ‘input’ means to put something in. So these devices are used to put the data inside the 

computer hence called input devices.  
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These devices are used to enter the data into the computer as well as to instruct the computer in any 

of the given ways such as using voice, typing, clicking or touching the screen.  

An input device is the main way to communicate between a man and machine because it provides us 

with storing the required data to the computer to maintain that for home or business purpose. The 

names of some main input devices are given below: 

Keyboard, Mouse, Joystick, Light pen, Locator, Web Camera, Scanner, Touch Screen and voice 

input.  

Keyboard: - A keyboard is the most useable input device which is used to enter the data and 

instructions into the computer.  

Mouse: - A mouse is an input device that plays a major role while working with computer. A mouse 

points the programs by its pointer hence also known as pointing device. It is used to operate on all 

the window based programs, internet and multimedia by selecting and instructing them.  

Joystick: - A joystick is an input device mainly used for video games. It sends the signal to the game 

prone programs to enjoy the games by moving the cursor on objects in them in the desired direction.  

Light pen: - it is one of the input devices that are used to input designs of the graphics to the 

computer. It is pen like photosensitive instrument and senses a position on the CRT (Cathode Ray 

Tube) when it is pointed towards the screen. 

Locator: - A Locator is an input device which moves the cursor around the screen to locate a desired 

point in a picture. It may also be used to change or expand a picture or its part.  

Web Camera: - A web camera is an input device which is used to send the live video over the 

internet as well as to record the video to display on computer.  

Scanner: - A scanner in an input device which is used to scan (read) images and text by scanning 

them which may be saved on computer and edited again.  

Touch Screen: - The data can be entered by simply touching the sensitive area of the screen. A 

monitor that has a touch – sensitive panel on the screen is called a touch screen. One can interact 

with the computer by touching areas of the screen with finger which acts as an input device.  

Voice Input: - A Voice input system is a microphone which is used to convert human speech into 

electrical signals which again and transmitted to the computer to produce the required output.  

OCR (Optical Character Reader):- This technique is used to read the printed characters directly 

and convert them into an appropriate code before storing into the computer. It may also be used for 

validating the examination papers and application forms. It does not required any special type of ink 

for reading but can recognize many different OCR fonts as well as typewriter  and computer printed 

characters. An advance OCR system can recognize (read) handmade letters and numbers.  

MICR (Magnetic Ink Character Recognition):- Magnetic Ink Character Recognition is widely 

used in banks to process a number of cheques written daily. Each cheque has a pre-coded bank 

number, account number and cheque number at the bottom with the special ink consisting of 

magnetizable particles of iron oxide. When a cheque is presented for payment, this same ink is again 

used by bank to encode the amount in the lower right corner.  

OMR (Optical Mark Reader):- OMR is a recognizing device that is used to read and recognize the 

information from a paper available in special form such as circles, a bar of a square darken with a 
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pencil. An OMR converts the darken spots into electronic pulses which can further be manipulated 

by a computer. The main use of OMR device is to examine objective type question papers, bar-chart 

evaluation, market analysis and weather data processing. 

 

1.7.2 Output Device 

As the name suggests, these devices are used to produce the output either on screen or printer. The 

output may be in the form of soft copy, hard copy or voice where the soft copy output is the screen’s 

output, hard copy output is the printer’s output and the voice output is the speaker’s output.  

An output device also provides the communication between the computer and the user and produces 

the results of various operations, performed on computer. The names of some main output devices 

are given below: 

Monitor, Printer, Plotter and Speech Synthesizer.  

Monitor: - A monitor is the most commonly output device. It is also called a screen or VDU (Visual 

Display Unit). It is just like a TV screen that displays the text and graphics on its screen. It displays 

everything which is typed through keyboard and also produces the results of the programs and 

calculations performed on computer.  

Printer: - A printer is also the main output device which produces output on paper called a hard 

copy output. Any type of data i.e. text and graphics displaying on the monitor can be printed on the 

paper by the printer. 

Plotter: - A plotter is also an output device which is used to produce line drawings with different ink 

colors. A plotter has a drum or flat bed holders to hold the paper and a carriage to move the paper 

while printing.  

1.7.2.1 Printers 

Printers are the most commonly used output devices use to produce the hard copy information 

displayed on screen. A printer can print numeric and scientific calculations, text, tables, objects and 

images processed on computer. A printer has a good printing speed which is measured by the 

characters per second or the pages per minutes. The printing speed depends on the quality of the 

printers.  

Types of printers 

There are two distinct categories of the printers impact and non impact printers.  

Impact Printers 

These printers have the mechanical contact between their printer head and paper. The pins available 

in the print head are physically hit against the ink ribbon and hit characters formed by the dots of 

pins are printed on the paper. Such printers less expensive. Following are the examples of impact 

printers.  

Daisy Wheel Printer (Character Printer) 

A daisy wheel printer prints a solid font type character at a time in speed of dots. It as a wheel of 

characters where each petal of this daily wheel has a character embossed on it. A printer hammer 

strikes the character to produce its output when the desired character is hit.  

Dot Matrix Printer 
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A dot matrix printer prints one character at a time. The characters are formed by the dots which are 

formed by the pins of print head. A print head of a dot matrix printer contains of 9 to 24 pins. The 

characters are formed by striking these pins on the printer ribbon which inserts dots dots on the 

paper.  

Line Printer 

A line printer prints a complete line at a time. The line printers are normally designed for heavy 

printing applications and can be operated continuously with many hours. These printers have faster 

speed than that of dot matrix printers and can print 150 to 2500 lines per minute. The line printers 

may be Drum printers or Chain printers.  

 

Non-Impact Printers 

Non-Impact Printers do not have pins and ribbons. They do not also have any mechanical contact 

between the print head and paper. These printers use thermal, chemical electrostatic and inkjet 

technologies and spray the colors by holes or laser beams. Such printers produce the best quality 

output. Following are the examples of non-impact printers: 

Inkjet Printer 

An inkjet printer produces a high quality output by spraying small drops of ink through its print 

head. This printer has a print head which contains several tiny holes through which the ink is 

sprayed. An inkjet printer has low speed and can print only 2 to 10 pages per minute. 

Laser Printer 

A laser printer produces the finest quality output with a very fast speed. Its laser beams make the 

images visible by a toner and transfer them on paper. 

 Each laser printer has its own CPU (Central Processing Unit) that processes instructions and 

manages the flow of information and also determines the speed of printing of the text and images. 

Generally a laser printer prints 4 to 16 pages per minute.   

Plotters 

A plotter is an output device that draws graphs and other pictorial images as series of point-to-point 

lines. It produces high quality line drawing on paper with one or more automated pens. It can draws 

continuous point-to-point lines directly from vector graphics files.  

 Plotters are most frequently used for CAE (Computer Aided Engineering) applications such 

as CAD (Computer Aided Design) and CAM (Computer Aided Manufacturing). There are a number 

of different types of plotters, viz. drum plotter, flatbed plotter and an electrostatic plotter.  

Drum Plotter 

Drum plotter is a graphics output device that draws lines with a continuously moving pen on a sheet 

of paper rolled around a rotating drum. The drum turns to produce one direction of the plot and the 

pens move to provide the other direction. The plotter was the first output device before color inkjet 

printers to print which could print graphics and large engineering drawings using different color 

pens.  
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Flatbed Plotter 

Flatbed plotter is a graphics output device that is used to draw the images with the help to attached 

several different color pens. It contains a flat surface (bed) that the paper is placed on. Unlike 

moving paper in drum plotters the paper is fixed on a flat surface and pens are moved to draw 

images.  

Electrostatic Plotter 

Electrostatic Plotter is an output device that uses an electrostatic method of printing. This plotter is 

used to draw images on negatively charged paper with positively charged toner. An electrostatic 

plotter enables to print in black and white or color and can handle paper up to six feet wide. Newer 

electrostatic plotters are really large-format laser printers and focus light on a charged drum using 

lasers or LEDs.  

 

Scanners 

A scanner is a peripheral input device that is used to read the complex images and text into a 

computer. It converts the pictures such as photographs, drawings and logos into digital form 

(machine understandable form) and shows them as it is on the monitor with the help of scanning 

software. The scanned image can be stored in a file to again access or edit it.  

 A scanner works like a Xerox machine using laser beams and displays the inserted images or 

text on the monitor.  

Types of Scanner 

There are the following types of scanners which can be used according to the nature of work. 

Hand Held Scanner 

A hand held scanner is useful for copying small image such as signatures, logos and small 

photographs. It can scan images which are up to four inch wide in size.  

Sheet-fed Scanner 

This scanner can scan only single sheet of paper at a time. The page from which and image is to be 

scanned, is passed thorough it like a laminations machine does.  

Such scanners are less expensive but take much and produce simple quality outputs.  

Flatbed Scanner 

This scanner can also scan single sheets of papers having images. It produces a better quality output 

and consumes less time. Such scanners can scan large images. Most of the flatbed scanners scan A4 

size (8½” X 11”) documents of images and text.  

 

 

1.8 Memory of Computer 

A computer’s memory is an essential part of computer that is used to store the programs and data 

temporarily to execute the user programs permanently for future use. It can be divided into two 

categories viz. Primary Memory also known as main memory and Secondary Memory.  

1.8.1 Main Memory (Primary Memory) 
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The main memory also called primary memory is a very fast memory. It stores programs along with 

data to be executed. It also stores necessary programs of system software which are required to 

execute the user’s programs.  

This memory is a temporary memory and directly addressed by the CPU. The data stored in this 

memory is lost on the electricity failure on when the computer is turned off. This memory is of two 

types viz.  RAM (Random Access Memory) and ROM (Read Only Memory).  

 

 
                                     Types of Primary Memory 

 

RAM (Random Access Memory) 

This memory is a main memory that stores the data temporarily. The data remains in so long as the 

computer is not turned off or the power supply does not go off. This memory is also known as Read / 

Write memory since the data can be stored and retrieved. It has a series of storage locations where 

data is stored in a series of horizontal and vertical rows and provides fast access to the CPU.  

There are two types of RAM: - Dynamic RAM, Static RAM 

Dynamic RAM: - In Dynamic RAM each cell of memory is made up of one transistor and one 

capacitor. Transistor works as a switching device which gives two states on and off. Capacitor store 

charge in it when transistor is on, current is passed and capacitor get charged forming 1(one) bit else 

0 (zero) bit. But in this there is a leakage in the capacitor due to which charge gets reduced and the 

capacitor is to be charged again. This process is called regenerator of charge or charge is refreshed. 

Since this process happens again and again so called Dynamic RAM. We use this because of simple 

circuit and less cost.  

Static RAM: - Static RAM contains more than one transistor and capacitors, therefore more space is 

needed hence it is more expensive. But, it does not lose its charge.  

 

ROM (Read Only Memory) 

As the name suggests, this memory is only a readable memory. It contains a set of instructions which 

can only be read but not altered. These instructions appear on the screen as soon as the computer is 

Primary 

Memory 

RAM

Static Dynamic

ROM

EROM PROM EPROM EEPROM
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turned on and execute the small an extremely basic programs for which these were written during 

manufacture.  

The ROM usually contains the Bootstrap Loader which loads an operating system into the memory. 

This operating system when loaded makes the system ready to load other programs.  

However the contents of ROM (use for micro programs and not available to normal programmers) 

cannot be changed or removed but can be fabricated for special purpose by the programmers in the 

following manners: 

EROM (Erasable Read Only Memory) 

This is the type of ROM, the contents of which can be erased making the ROM reusable. However, 

since the erasing process involving removal of the chip from the CPU, such chips are hardly suitable 

for use by the application programmers.  

PROM (Programmable Read Only Memory)  

A variation of the ROM chip is Programmable Read Only Memory (PROM). The ROM chips, on 

which a user can write his own program to record information is known as PROM. A PROM is also 

called a non-volatile storage as the recorded information cannot be altered.  

EPROM (Erasable Programmable Read Only Memory) 

To alter the recorded information on the ROM chip and to record a new different information, 

erasing is achieved by exposing the chip to ultra violet light. When an EPROM is in use, information 

can only be read and it remains on the chip until it is erased.  

EEPROM (Electrically Erasable Programmable Read Only Memory)  

A ROM chip is again programmed and erased by electrical signals. The EEPROM memory uses 

only small charges of electricity to represent the information contained in it.  

Advantages of ROMS 

➢ Non-volatile in nature. 

➢ Easier to interface than RAMs. 

➢ These cannot be accidentally changed. 

➢ Cheaper than RAMs. 

➢ Easy to test.  

➢ More reliable than RAMs. 

➢ These are static and do not required refreshing. 

➢ Its contents are always known and can be verified.  

 

1.8.2. Secondary Memory 

Since the data of primary memory are stored on temporary basis and lost as soon as the power is 

switched off, so far storing data and programs permanently, a secondary memory is used. This 

memory is also called auxiliary memory, permanent memory, magnetic memory and backup 

memory. It consists of the storage devices to store a large amount of data and programs permanently.  
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Backup memory or Storage Devices 

Storage devices are the devices that are used to store the information for backup as well as to retrieve 

that on demand. These devices come under secondary memory. The following are the definitions of 

various different storage devices: 

Floppy Disk 

A floppy disk is a small storage device made up to flexible plastic coated with magnetic materials in 

square size. It is the small secondary storage device which can be used for both input and output 

operations. The main use of floppy disk is to store and transfer data from one computer to another. A 

floppy disk is also called a removable disk because data can be restored again and again by 

removing last data. A floppy disk is divided into logical concentric (having common center) circles 

called tracks and tracks are further divided into sectors where the data is physically recorded. A 

floppy disk is in the size with 3.5 inches in diameter with 1.44 MB capacity.  

Hard Disk 

A hard disk is the most powerful secondary storage device which is permanently fixed inside the 

CPU. It is made up of aluminium platters covered by a dust proof case. A hard disk is small in size 

but capable of storing a huge amount of data. Its storage capacity is measured in gigabytes (GBs) 

which is equal to that of hundreds of floppy disks. Now-a-days hard disks are available in 80 GB, 

160 GB and even up to 1 TB (Tera Byte) of data storage capacity.  

CD-ROM (Compact Disk – Read Only Memory)  

A CD (Compact Disk) is a secondary storage device which is used to store a large amount of data. It 

is of higher capacity and reliable storage media that provides more room for storing large images, 

animation and video. A CD – ROM is a compact disk read only memory which can transfer the 

stored data to the computers but does not allow to change the data once stored on it. A single CD – 
ROM disk can store up to 650 or 700 MB of data which may be equal or more than that of 400 

floppy disks.  

DVD-ROM (Digital Video Disk – Read Only Memory) 

A DVD – ROM stands for Digital Versatile (or Video) disk read only memory. Like a CD –ROM, it 

is also used for transfer or enjoy the stored data, animations and pictures but does not allow to 

change the data stored on it. It is similar in size and shape to a CD-ROM but can store more data i.e. 

between 4.7 GB to 17 GB of data.  

Magnetic Tape  

A magnetic tape is a data storage media that works as a tape recorder. It is a plastic ribbon coated 

with magnetic material whereas one side is coated with iron oxide. This is the side where data is 

recorded sequentially in the form of tiny invisible spots by electromagnetic pulses.  
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USB Flesh Derive (Pen Drive) 

A flesh memory card that plugs in to the computer’s USB (Universal Serial Bus) point. It is a small 

secondary storage device that allows data to be transferred from one computer to another. USB 

Drive is also known as USB drive, Pen Drive, Key Drive, Flesh Drive and etc. is looks like a pen 

hence very popularly known as a pen drive. It stores more data than a floppy or a CD (Compact 

Disk). We may get a pen drive in 1GB, 2GB, 4GB, 8GB, and 32 GB. 

1.9 Internet Basics  

 

Introduction to internet 

As the name suggests, it is the international network which is often called the Net, the Information 

Superhighway or Cyberspace. The Internet is the network of networks. It is the largest computer 

network in the world which consists of thousands of connected networks with cables, telephone lines 

and satellites. It is the most popular and worldwide used media of getting information, used by 

millions of people throughout the world daily.  

 It is the most powerful and fastest media to collect information of whole the world, to send 

and receive e-mails, chat, online shopping and etc.  

 The internet provides most of the information free of cost which is provided to educate and 

entertain the people by governments, universities, colleges, companies and individuals. To use the 

internet, a modem is attached to the computer which enables the telephone line to be connected to 

the computer or a cable provided by ISP (Internet Service Provider) who installs a main server 

distributes connections to the users. The internet offers the following facilities to all its users: 

World Wide Web 

The World Wide Web also known as web is a part of the internet. It consists of a vast collection of 

documents (pages) of information stored on computers around the world. These documents include 

text, images, pictures, sound, audio, video programs and interactive environment.  

Electronic Mail (E-mail) 

An electronic mail or e-mail is the most popular feature on the internet. This feature enables people 

to send and receive messages and files through computers globally.  

Entertainment  

The internet offers many different forms of entertainment such as radio broadcasting, video clips, 

music, pictures and interactive games which can be enjoyed on the internet easily. 

Information  

The internet gives access to information on any subject imaginable which makes the internet a 

valuable research tool. Newsgroups, magazines, academic papers, dictionaries, encyclopedias (book 

of all around knowledge) travel guides, government documents, job requirements, airline and 

railway schedules can be reviewed.  

Chat 

The internet allows us to exchange our typed messages with another person or a group of people at a 

time on it.  
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Programs  

The internet provides a number of different programs such as text and graphics, business and 

educational, audio and video, games and other entertainment which can be downloaded and stored in 

the documents on the disk. 

Online Shopping 

Through the internet, we can order goods and services. We can purchase different items such as 

books, clothes, computer programs, flowers, CDs, and Cars etc. through the internet.  

Voice and Video Conferencing  

It enables two or more people to converse face to face by sharing a whiteboard and other 

applications.  

Discussion Groups 

The facility enables one to meet people around the world by joining discussion groups on the 

internet. These groups also enables also enable to ask questions, to discuss problems and to read 

interesting stories. 

 

Getting Connected to the Internet 

To get connected to the internet on a computer, a modem and telephone line or an internet cable is 

required. Now-a-days a system known as Broadband is providing much faster speed than standard 

modem (56k). It also provides to chat to over friend on the same phone line at the same time. The 

number of ISP’s providing now this service.  

We can connect to broadband in windows XP operating  

system in the following way.  

➢ Click on start button.  

➢ Click on control panel. 

➢ Click on Network connections.  

Once we get connect to broadband, we can directly enjoy 

Internet Surfing using the following steps: 

➢ Click to open any web browser, i.e., Internet Explorer,  

 Google Chrome, Opera, Mozilla Firefox from desktop.  

 Enjoy Internet surfing by opening sites using www.any  

 site name.com on the address box of browser: 

➢ To come out the internet, click on any close button.  

 

 

Here we take Windows 7 as an example, and please make sure that your Ethernet Adapter is working 

well.  
 

Step 1 Please Click the Start button, go to Control Panel. And then go to Network and Internet-View     

network status and tasks page. 
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Step 2 Click on Set up a new connection or network. 

 

  

  

Step 3 Select Connect to the Internet and click Next button. 
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 Step 4 Click on Broadband (PPPoE). 

 

  

  

Step 5 Type in the information from you ISP. Please make sure all these information is correct. And 

then, click Connect button. 

  

 

 

 

If all your information is correct, you may get the window below and you can surfing the Internet 

now. 
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Step 6 At this time, you have created the PPPoE dial up connection successfully. At the right side 

corner of your screen, click the same icon which looks like a computer, you can a Broadband 

Connection. You can disconnect or connect through the broadband connection. 
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World Wide Web 

 

The World Wide Web usually refers to as “the Web” is a part of internet. It consists of a vast 

collection of documents (pages) of information stored on computers around the world. These 

documents represent text documents, images, pictures, sound, audio, video programs and interactive 

environment. The web is probably the largest and most diverse (various, different) collection of 

information the internet supports.   

 The World Wide Web is also known by its 

abbreviated names such as WWW, W3, or Simply 

Web. Tim Berners-Lee, scientist at CERN 

(Counsel European Research Nuclear), a Particle 

Physics Laboratory in Geneva, Switzerland is 

widely known as the father of the Web.  

 The web is made up to special sites along 

the internet that support web browsing. Most of 

these sites have information used to educate and 

entertain the children and people. A number of 

business sites are available which provide the new 

products, old and antique (very old, historic) 

products and other items.  

   

 

 

 

Web Servers 

 

A web server is a computer on the internet that makes web pages and sites available for the 

web browser. It is used to store the retrieve the web pages and delivers them in response to requests 

from web browsers. It acts as an advertising medium and as a communication tool that provides link 

between people and web pages.  

 There are literally (exactly) millions of web servers on the internet each of which having 

homes of thousands of web pages.  
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Web Sites 

 

A web site is simply a collection of inter-linked 

web pages. It contains information about an 

individual, company or organization available on 

one or several pages called web documents or web 

pages. These pages may contain information in the 

form of text, images, pictures, sound, audio and 

video and can be switched pack and forward by 

clicking their links called hyper-links. Following 

are the names of web sites:  

 www.gmail.com 

www.gcwnnl.edu.in 

www.mduonline.org 

 

 

Web Pages 

 

Web page is an HTML document that is 

designed to provide information on the internet. 

It is the best media of advertisement on the 

internet that provides much better and latest 

information on the products, business, education 

and other topics over the world. A web page is a 

visual art of much largest system to 

advertisement that is basically known as World 

Wide Web and in its abbreviated forms such as 

WWW, W3 and Web.  

 A web page behaves like word 

processing document and contains text, image, 

sound, pictures and hyperlinks together web 

pages. It contains HTML tags that enable us to 

find, retrieve, manipulate and display the 

document worldwide on the net. Following is an 

example of web page.  

 

Web Browsers 

 

A web browser is the program that is used to navigate 

(find the way, walk) through information found on the 

net. It allows to view and retrieve the information spread 

across the internet and displays it using the Hyper Text 

Markup Language (HTML). It communicates with the 

web servers to download and display the web pages on 

the computer and provides a full multimedia experience 

with pictures, sounds, videos and even 3D imaging. 
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Electronic Mail 

An electronic mail or e-mail is the most popular feature on the internet. It is fast, easy, inexpensive 

and time and paper saving media for sending messages to people through computers globally. One 

can exchange e-mail with friends, relatives, family members, customers and other people around the 

world.  

 

E-mail Address 

An e-mail address is the address on the Internet that is used to send e-mail to anyone 

anywhere. It defines the location of an individual’s e-mail address (also called e-mail account, mail 

box or mailing address) on the internet.  

We can send any message file including text, graphics, sound, audio and video to anyone 

around the world on the internet if we know the exact e-mail address of that person.  

The e-mail address consists of two parts; the user name and the domain name joined by @ 

(at) sign. It does not allow blank spaces and uppercase letters. The following example illustrates two 

different e-mail addresses; 

 

             sharma_pk2020@yahoo.com 

        For Example          singhrp@gmail.com 

             ashu20@rediffmail.com 

    

    

        
     User name Domain name 

 

The user name is used in the starting of an e-mail address which can be a real or nick name of the 

user or company. 

The domain or host name provides the Internet location of an e-mail address. Periods (.) are used to 

separate the various parts of the domain name.  

 

Creating an E-mail Address (Account) 

An e-mail is an electronic mail that is used to send and receive messages on computer through 

Internet. An e-mail account is mailing address or mail box owned by individuals on the internet. One 

can contain one or more e-mail accounts on the internet. These accounts can be created on the web 

sites easily using web browsers such as Internet Explorer, Google Chrome and Netscape Navigator 

using similar process.  

Take the following steps to create an e-mail account in g-mail site.    

 

❖ Open a web browser like Google Chrome. 

❖ Visit Google account creation page, accounts.google.com 

❖ Click on Create account. 

❖ The sign-up form will appear. Enter your first and last name. 

❖ Choose a Username for your account. (Here you can also use an existing email address) 
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❖ After choosing a username, enter a password. Type the password again to confirm. (As per 

Google's instruction always use 8 or more characters with a mix of letters, numbers & symbols) 

❖ At last tap on Next. (Right corner of the screen) 
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❖ On the next page enter your phone number to verify your account. (It is a two-step verification 

process for security) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

❖ On the given mobile number you will receive a text message from Google with a verification 

code. Enter the verification code and tap on Verify. 

❖ On the next page enter your DOB in the specified fields. 

❖ Choose a Gender. 

❖ Tap on Next. 

❖ Read, Google's Terms of Service and Privacy Policy will appear on the screen and click on I 

agree. 
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Congratulations! Your account has been created. From now onwards every time you sign in you 

just have to enter your email id and password. And every time you sign-in don't forget to sign-out 

because it prevents others from viewing your emails. 

Do you know how to sign-out? 

Navigate to the circle (in the top-right corner of the page). Here tap on it, from the below option, 

select Sign-out. 

Sending & Receiving E-mails 

Open Gmail. Go to https://www.gmail.com/ in your computer's web browser. This will open your 

Gmail inbox if you're logged in. 

• If you aren't logged into your Gmail account, enter your email address and password when 

prompted (on time, quick). 

• Click ＋ Compose. It's in the upper-left side of your Gmail inbox. Doing so opens a "New 

Message" window in the lower-right corner of the page. 

• Enter the other person's email address. Click the "To" or "Recipients" text box at the top of 

the New Message window, then type in the email address of the person to whom you want to 

send your email. 

• To add multiple email addresses, type in the first email address, press Tab ↹, and repeat with the 

other email addresses. 

• If you want to CC or BCC someone on the email, click either the Cc link or the Bcc link in the 

far-right side of the "To" text field, then type the email address you want to CC or BCC into the 

"Cc" or "Bcc" text field, respectively. 

• Add a subject. Click the "Subject" text field, then type in whatever you want the subject of the 

email to be. 

• Typically speaking, an email subject describes the gist of the email's message in a few words. 

• Enter your email message. In the large text box below the "Subject" text box, type in whatever 

you want for your email message. 

• Format your email's text if needed. If you want to apply formatting to your text (e.g., bolding, 

italics, or bullet points), highlight the text to which you want to apply the formatting, then click 

one of the formatting options at the bottom of the email window. 

• For example, to bold a section of text, you would highlight the text and then click B at the 

bottom of the email. 

• Attach a file if you like. To add a file from your computer, click the "Attachments" icon at the 

bottom of the window, then select the file(s) you want to upload and click Open (or Choose on a 

Mac). 

• You can add photos in this way, or you can upload photos directly to the email's body by 

clicking the "Photos" icon at the bottom of the window, clicking Upload, clicking Choose 

photos to upload, and selecting photos as needed. 

• Click Send. It's a blue button in the bottom-right corner of the email window. Doing so will 

send your email to the specified email address (es). 

 

 

https://www.gmail.com/
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Surfing the Internet 

Def: - Surfing describes the act of browsing the Internet by going from one web page to another web 

page using hyperlinks in an internet browser. It is the process of navigating through the World Wide 

Web. 

 

Def:-Surfing the Internet is a term typically used to describe an undirected type 

of web of browsing where users whimsically follow one interesting link to another without a planned 

search strategy or definite objective. Surfing the net has become a popular pastime, for 

many Internet users. 

 

Def: - Surfing describes the act of browsing the Internet by going from one web page to another web 

page using hyperlinks in an Internet browser. The term "surfing" was first coined by Mark McCahill 

 

Internet surfing usually involves the following steps:- 

• Starting an Internet Browser (Note: - Browsers are software programs that allow to you move 

from one page to another on the internet.) 

• Typing the address of a web page in the address field or location box of the web browser.  

• Indentifying and use of common buttons on the browser toolbar like Back, Forward, Home. 

• Navigating or moving between web pages. 

 

Reasons for surfing the internet 

• There is a large amount of information is currently available on the internet, in mostly people 

especially the students got benefits by internet surfing.  

• Through surfing the internet, the students have been able to share information with their 

colleagues by creating their own websites that show their interests. Internet surfing has also 

made it possible for people to share memories via videos and pictures.  

• Students have also had the privilege of attending online classes through internet surfing without 

having to physically move from their homes. 

• This has had the benefit of helping students overcome geographical boundaries and be able to 

study at educational institutions of their choice. 

• Surf the internet for various reasons, which include online shopping instead of having to literally 

move from one shopping mall to another. 

 

 

 

  

https://www.computerhope.com/people/mark_mccahill.htm
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An Introduction to Microsoft Word 2007 

Microsoft offers a bundle of software programs within MS Office, with each offering a different 

function.  Microsoft Word is a word processing program similar (but better than) the antiquated 

(out of date) Word Perfect or the Microsoft Works Word processor.   Just like any other word 

processing program, you use MS Word to view and edit formatted text within a document.  A 

formatted text document is defined as a document that contains text which may be in bold, 

italics, underlined, a different color, or a different font.  All word processing programs can do all 

of this, but Microsoft Word allows you to do a lot more.  For that reason, Microsoft Word is the 

most used word processing program in existence today. 

Microsoft word is a software that helps you to create neat and attractive documents easily and 

quickly. You will find its multi-facilitated capability quite handy in drafting letter casual and 

official letter, preparing mailing lists and reports.    

Various Features of MS WORD  

The word processor has many unique features as follows: - 

1) Typing easy: In MS WORD typing is so easy because we need not click enter button after 

end of the line as the type writer. The word processor itself takes matter to the next line of the 

document. This facility is called word wrapping. There is no limit for typing the matter. You can 

easily correct mistakes as the typing matter appears on the screen. 

2) Saving: The document type can be stored for future use. We can preserve the document for 

any number of years in word processing. 

3) Adding, removing and applying text: Documents can be modified easily in MS office we 

can easily place a new word in place of existing one. The new words will automatically be 

adjusted in the place of deleted or modified text. We can also copy a part or whole of the matter 

from one document to another document. 

4) Spell check of words: The spelling of the words in the document can be rectified 

automatically we can also find alternative words to our typed words. The grammatical errors can 

also be rectified in word processor. 

5) Change the style and shape of characters and paragraph: The documents in word 

processor can be made attractive because the shape and style of characters in the documents can 

be changed according to our requirement. 

6) Bullets and Numbering: Bullets are special symbols which can be put for different points, 

paragraphs and documents where as numbers are ascending figure while 1,2,3 etc. 

7) Headers and footers: A header is the text appearing above the documents and footer is the 

text appearing below the documents. 

https://rankways.com/
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8) Creation of tables: If you give directions for required number of rows and columns word 

provides a readymade table to work. 

9) Inserting pictures and objects: In the word processor we can insert the pictures in the 

document to make it more attractive. These pictures can be obtained from clip art which is 

available in word processor. 

10) Preview facility: Before getting a print out of our document we can get a preview of 

document if mistakes are there we can change the document. 

11) Mail merge facility: If you want to send information to different persons there is a facility in 

word processor known as mail merge the main body of the letters can be typed once and we can 

send the same to different addresses. 

12) Macros: With the help of macros we can avoid certain type of repetitive works. This saves 

our time and efforts. 

Starting Microsoft Word 2007 

You open Microsoft Word by clicking on the icon on 

your desktop (if you have one there) or in the program 

bar.  The icon for Microsoft Word 2007  

When you click on the icon, a blank document will open.  This is a new document for which the 

default name is Document1.   For each additional new document that you open, the name 

increases by one digit: Document2, Document3, etc.  If you start MS Word by clicking on an 

already existing document on your computer, it will open automatically and your document will 

be displayed in the MS Word window. 

Virtual Tour of MS Word 2007 

There are main components of the MS Word 2007 window that you need to be aware of before 

we even get into features and functions.  

As with any software program or web page that you look at, the line allows 

you to minimize the page, the box allows you to maximize, and the X closes 

out the page on your computer.   Don't worry.  If you should accidentally 

click the X, MS Word will prompt you to save the document.  

The Ribbon in Word 2007 

Once you get used to it, you'll find the Ribbon is far easier to use than the file menu interface 

used in previous versions of word. 

By default the Ribbon is divided into seven tabs, with an optional eighth tab (Developer) they 
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are: 

Home: This contains the most-used Word features, such as changing fonts and font attributes, 

customizing paragraphs, using styles, and finding and replacing text. 

Insert: As you might guess, this one handles anything you might want to insert into a document, 

such as tables, pictures, charts, hyperlinks, bookmarks, headers and footers, WordArt ... etc. 

Page Layout: This is where you'll change margins, page size and orientation, set up columns, 

align objects and add effects. There is some overlap between this tab and the Home tab. E.G. On 

the Page Layout tab you set paragraph spacing and indents, while on the Home tab you set 

paragraph alignment and can also set spacing between lines. 

References: This tab handles tables of contents, footnotes, bibliographies, indexes and similar 

material. It also lets you insert a "Table of Authorities," which like a security setting but is in fact 

is a list of references in a legal document. 

Mailings: As the name says, this is where you'll go for anything to do with mailings, from 

something as simple as creating labels to the more intimidating task of mail merges. 

Review: To check spelling and grammar use the thesaurus, track changes, review other people's 

changes or compare documents? This is the tab to use. 

View: This tab allows you to change the view in any way, including displaying a ruler and 

gridlines, zooming in and out, splitting a window and so on. 

Developer: To display this tab, click the Office Button and choose Word Options > Popular > 

Show Developer tab in the Ribbon. Most users will only need this tab to record Macros but if 

you write code or want to create forms and applications for Word, this is your tab. 

 

Each tab along the Ribbon is organized to make it easy to get your work done. As you can see 

below, each tab is organized into a series of groups that contain related commands for getting 

something done. Inside each group is a set of command buttons, (these buttons as the name 

suggests, carry out commands, display menus etc, in the example below, the “ B ” command 

button changes the font to bold. There's also a small diagonal arrow in the bottom right corner of 

some groups that are called dialog box launchers. Click it to display more options related to the 

group. 

 
 

 

 
 

 

             
           Dialog box 

                                                                   

 

 

Tab 

Command Group 
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The part of the Ribbon that takes the most getting used to is that it changes according to what 

you're doing. Depending on the task you're engaged in, it adds or removes tabs and sub tabs. For 

instance, when you insert and highlight a picture, an entirely new tab appears -- the Format tab, 

with a "Picture Tools" supertitle on top, as you can see below. 

The Office Button and the Quick Access Toolbar 

Two tools that make life easier in Office 2007 are the Office Button and the Quick Access 

toolbar. 

The Office Button 

The Office Button is like a greatly expanded File menu from Word 2003. 

As you can see from the screen shot below, it's where to go for the various Open, Save, New, 

Print and related options, it also includes a list of all your recently opened files. 

Some of the more useful new features accessed via the Office Button are: 
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Prepare –when you've finished writing or editing your document and you're ready to send it to 

someone else. There are plenty of options here, such as marking a document as final or read-

only; encrypting the document; inspecting it for hidden metadata and information you'd prefer 

remain private also here is where you can edit a document's properties, such as title, keywords 

and author. 

Publish –gives options for publishing a document. You'll be able to publish your document as a 

blog to a variety of blogging services, including Blogger, Windows Live Spaces, etc. If your 

company uses a document management server or SharePoint, you can publish it there as well. 

Convert – this feature lets you convert documents saved in older formats (.doc etc) to the new 

Microsoft Office Open XML format (.docx, the new Office standard). 

Word Options – For those who like to fiddle with the Word interface and how it works, the 

Word Options button, located at the bottom of the Office Button's box, lets you customise Word 

in many ways, including its display and editing options. It has many of the features that you 

accessed via Tools > Options in previous versions of Word. 

The Quick Access Toolbar 

Sitting just to the right of the Office Button, the Quick Access toolbar seems a minor addition, 

but after a while you'll see it's a very handy tool. 

The three default buttons Save, Undo and Redo are good to have, but the almost invisible Down 

arrow to the right of them is the key to the toolbar. Click it, and you'll be able to add and remove 

toolbar buttons for a preset list of commands and customize the Quick Access toolbar to your 

liking. 
 

By adding your own shortcuts to the Quick Access toolbar you will greatly reduce the time it 

takes to do all the tasks you do on a regular basis. 
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Another way to add commands to the quick access toolbar is to click the Office Button, choose 

Word Options > Customize. 

The Customize the Quick Access Toolbar and keyboard shortcuts screen is shown. 

Choose a command from the left-hand side of the screen that you want to add to the Quick 

Access toolbar and click Add. 

You can change the order of the buttons by highlighting a button on the right side of the screen 

and using the “Up” and “Down” arrows to move it. 

The list of commands you see on the left may seem somewhat limited at first. That's because 

Word is showing you only the most popular commands. There are plenty of others you can add. 

Click the drop-down menu under "Choose commands from" at the top of the screen, and you'll 

see other lists of commands. (All Commands, Home Tab and so on) Select any option, and there 

will be plenty of commands you can add. 

 

 

Finally, and probably the easiest is to right-click any object on the Ribbon and choose "Add to 

Quick Access Toolbar." You can add not only individual commands in this way, but also entire 

groups. (E.g. the Font group). 



M.A. English Sem. 1st  Unit -2nd Computer Applications  ENG-VIII 

GCW, Narnaul 
7 

 

Opening a New Document:- Opening a new 

document can be accomplished two ways.  The first 

way is to click on the MS Word 2007 icon on your 

computer.  If you already have MS Word open and 

wish to start a new document, simply click on the 

Window Office button and select 'New'.  You will 

be presented with the screen pictured. 

On the left, you have templates that you may 

choose from.  If you would select 'Award 

Certificates,' you would then see a screen that 

would allow you to choose a certificate template as 

your new document. 
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Saving a Document 

Let's say that you've created a new document and wish to save it to your computer to use again 

later.   You can do this quickly and easily in MS Word 2007 in one of two ways.   The first way 

is to use the Microsoft Office button.  Click on it, then scroll down to select either 'Save' or 'Save 

As'.  Clicking 'Save' will enable you to save the file under its current name.  Keep in mind that if 

this is a new document, it will save the file by the default name of Document1.  When you click 

'Save,' if another file of the same name exists, MS Word will prompt you to either enter a new 

file name or to replace the existing copy with the new version you are currently saving. 

Clicking 'Save As' gives you a lot more options to saving your work.  First of all, when you click 

'Save As,' you must specify a file name.  You must also specify the format that you want to save 

the file in.   MS Word's default file format is .doc or Word Document. This is an acceptable and 

much-used format that should be satisfactory for most MS Word users, but you can select the 

format that you need depending on the work you need to save.  You can also save your work as a 

template or in MS Word 97-2003 recognizable format if you'll be forwarding the file to users 

who may not have MS Word 2007.   When you click on 'Save As,' it will present all these 

options to you in a slide-out window to the right of 'Save As.'  

You can also save a document by clicking the picture of the floppy disk that is located to the left 

of the Quick Access button. However, this will save the file under the current name.  You will 

not be able to name the file or select the format.  It's a good idea to click this button every so 

often while working in a document to save it in case of a power outage, computer freeze, or 

anything else that may cause you to lose your work. 

Warning: Do NOT close MS Word without saving your document.  You MUST save your 

document using one of the methods listed above or your work will be lost forever. 

Getting Help with MS Word 2007 

If at any time you have a question or need to know exactly how to find or accomplish a task, you 

can also ask MS Word for help.  

In the upper right hand corner of the screen, you'll see a dark blue circle with a question mark 

inside.  This is the help button.  You can click on this and a menu will pop up so that you may 

find the answer to your question.  You can also bring up this help window by simply clicking F1 

on your keyboard. 
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You can use MS Word help to remind you how to complete certain tasks or to refresh your 

memory.  It is always there as a reference tool and is free to use. 

The Cursor 

If you've spent any time at all on the computer, you should be familiar with the cursor. In Word, 

it is a thick blinking black line. It is the line that lets you know where you are in the document 

and where characters will appear as you type. You can move the cursor anywhere in a document 

by using the arrow keys on the keyboard or by moving the mouse pointer to the desired location 

and clicking the left mouse button. 

The cursor moves to the right as you type and to the left as you backspace. 
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The cursor can be quickly repositioned to certain preprogrammed places in the document by 

using keyboard shortcuts. To move the cursor to the beginning of a line, use the HOME key. To 

move it to the end of a line, use the END key. To move the cursor to the beginning of the 

document, use CTRL + HOME and to move it to the end of the document, use CTRL + END. 

 

Inserting Text 

You can insert text anywhere in a document simply by moving the cursor to the desired location 

and typing. Word automatically moves all text to the right of the cursor as you type.   

Deleting Text 

You can delete text by using the Backspace and Delete keys. But you must remember that 

Backspace removes characters to the left of the cursor, and Delete removes characters to the 

right. To delete blocks of text, select the text to be deleted and press either the Backspace or 

Delete key. 

Moving Text 

You can move selected text by holding the left mouse button and moving the cursor to the 

desired location in the document. When moving text, a small box appears near the mouse pointer 

and the cursor turns into a broken black line. You position the cursor in the place you want the 

text and release the left mouse button. 
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Undo and Redo 

 But let's say you accidently delete something or deleted it and then decided that you want it back. 

You grit (patience) your teeth and start to grumble (complain), trying to remember the exact 

wording. It's a lost cause, right? Wrong. The makers of Word anticipated (likely) this problem 

and supplied an easy solution. The Undo button! 

The Undo button can be found in the upper left corner of the program window in what 

Microsoft calls the "Quick Access Toolbar" The Undo button is the blue arrow shaped 

like a comma. If you are not sure you've got the right button, you can move your mouse over it 

and wait and a small box that reads "Undo Typing (Ctrl-z)" will appear. Word allows you to 

undo up to 100 actions. 

The Redo button is to the right of the Undo button.  It looks like the recycle symbol you might 

see on trashcans at the airport. The redo button allows you redo an action that you just undid or 

to repeat the last action. If Word cannot redo the last action, the button will be faded.  

MS Word’s basic Commands 

New :- “New” command is use to open a new document. To open a “New” document click 

on “Office button” then click on “New” and lastly click on “Blank document” and then click 

on “Create” button 

Open:- From “Open” command we can open saved files. For example we have saved a file by 

the name of “Microsoft word” and now we want to open it so firstly click on “Office button” and 

then click on “Open” and lastly select your file and click open and we can also open a file by the 

help of Shortcut key. To open a file by the help of shortcut key click “Ctrl+O”. 

Save:- This command is use to save a document. To save a file click “Office button” then 

click “Save” command and “type the name” that in which name you want to save this file. For 

example I want to save a file by the name of “Microsoft notes” and then I click “Save”. The 

shortcut key for “Save” command is “Ctrl+S”. 

Save As:-“Save As” command is use to save a file by two or more than two names. What is 

difference between “Save” and “Save As” command. “Save” command is use to save a 

document by only one name but In “Save As” command we can save a file by two or more than 

two names. For example we have already saved a file by the name of “Microsoft Word” and now 

we want to save it by two names or more than two names as given below. The shortcut key for 

“Save As” is “F12”. 
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Print Preview:- Print preview command is use when you want to see your document that how it 

look when I will print it. To see your document click on “Office button” then bring your mouse 

pointer to “Print” and lastly click on “Print Preview” command.  

Print:- This command is use for print a file. If you want to print a file so First of all, click 

on “Office button” then click on “Print” command or click “Ctrl+P” from keyboard. 

Close:- To close a document in Word, click the File tab and choose the Close command or use 

the keyboard shortcut Ctrl+W. Word banishes the document from its window, but then the 

program sits there and waits for you to do something else, such as start working on a new 

document or open a document you previously saved. 

Copy:- To copy a piece of data to a temporary location. In word processing, for 

example, copying refers to duplicating a section of a document and placing it in a buffer 

(sometimes called a clipboard). The term copy differs from cut, which refers to actually 

removing a section of a document and placing it in a buffer. 

Cut:- Cut is a command that allows you to "cut out" a selection of text or other data and save it 

to the clipboard. It is similar to the Copy command, but instead of just copying the data to the 

clipboard, it removes the selected data at the same time. 

Paste:-  Paste is a command that allows you to insert data from the clipboard into an application. 

In order to use the Paste command, you must first use either the Copy or Cut command to save 

data to the clipboard. Once the clipboard contains data, you can paste the saved data into any 

supporting program. 

Find:- Find command is used to find specific text in a document you can also 

use Ctrl+F shortcut key.  

Replace:- Replace command is used to replace a name or word in a document.  

Undo:- Reverses the last change made in the text. This feature restores moved text 

to its original location. 

Redo:- Reverses the last Undo action. 

Bold:- Prints text darker than other copy as it is keyed. Bold may be added after 

text has been keyed by first selecting the text. 
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Borders:- Adds a border to any or all sides of a page, paragraph, or column, as 

well as to a table or a cell within a table. Page border options may include small 

pictures. Borders not only enhance appearance, but also make text easier to read 

by emphasizing certain passages. Borders are most effective when used sparingly. 

Bullets:- Highlights each item in a list with a heavy dot or other character, as 

demonstrated in this list of features. Bullets add visual interest and emphasis. 

Change Case:- Changes capitalization. The lowercase option changes all selected 

text to lowercase; the UPPERCASE option changes selected text to all capitals. 

The Sentence case option capitalizes the first letter of the first word, and the Title 

Case option capitalizes the first letter of each selected word. 

Drop Cap:- Formats paragraphs to begin with a large dropped capital letter. 

Drop caps are objects (pictures) that can be formatted and sized. 

Font:- Consists of the typeface, style, size, and any effects used. Font features may 

be changed before or after text is keyed. The number and size of fonts available 

depends on the software and printer used. 

Size:- Measured in points such as 10 point or 12 point. One point is about 1⁄72 

of an inch. 

Effect:- Added to give text a special look. Examples of effects are shadow, 

emboss, and small caps. Effects should be used infrequently. 

Italic :- Prints letters that slope up toward the right. Italic may be added after text 

has been keyed by first selecting the text. 

Numbering :- Shows the proper order of a series of steps or items. Use numbers 

instead of bullets whenever the order of items is important. 

Shading:- Adds color or patterns to paragraphs or table cells to emphasize them 

and focus the reader's attention on the contents. 

Superscript:- Places text slightly higher than other text on a line. Superscript is 

commonly used for footnotes and endnotes, and for mathematical formulas and 

equations. 
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Underline:- Underlines text as it is keyed. An underline may be added after text 

has been keyed by first selecting the text. 

Watermark:- Prints any desired text or graphics behind the main text on 

document pages. 

Formatting Features :- Formatting features change the arrangement, or layout, of pages. These 

features include aligning text vertically and horizontally, indenting and hyphenating text, and 

changing margins and line spacing. 

Alignment:- Refers to the horizontal position of a line of text (also called 

justification). 

- Use left alignment to start text at the left margin (even left margin). 

- Use right alignment to align text at the right margin (even right margin). 

- Use center alignment to center text between the left and right margins. 

-   Use justify alignment for even left and right margins. 

Center Page :- Centers text between top and bottom margins of a page. This 

feature leaves an equal (or nearly equal) amount of white space above and 

below text. Inserting two hard returns below the last keyed line gives centered 

documents a better appearance. 

Hyphenation:- Automatically divides (hyphenates) words that would normally 

wrap to the next line. When used with left-aligned text, hyphenation makes the 

right margin less ragged, making text more attractive. 

Indent:- Moves text away from the left or right margin. 

Left indent:-(paragraph indent) Moves the text one tab stop to the right 

(usually 0.5"), away from the left margin. 

Hanging Indent :- Moves all but the first line of a paragraph 0.5" (one tab 

stop) to the right. Hanging indent is commonly used on bibliographies and 

reference pages. 

Line Spacing:- Changes the amount of blank space between lines of text. 
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Margins:- Changes the amount of blank space at the top, bottom, right, and/or 

left edges of a page. Default margin settings are not the same for all software. 

Page Break:- Inserts a soft page break automatically when the current page is full. 

A hard page break can be inserted manually to start a new page before the current 

page is full. 

Tab:- Aligns text according to the type of tab set. By default, most word 

processing software programs have left tabs already set at half-inch (0.5") 

intervals from the left margin. These preset tabs can be cleared and reset. 

Left Tab:- Commonly used to align words, align text evenly at the left by placing 

the keyed text to the right of the tab setting. 

Right Tab:- Commonly used to align whole numbers, align text evenly at the 

right by placing the keyed text to the left of the tab setting. 

Decimal Tab:- Aligns numbers at the decimal point, regardless of the number of 

places before or after the decimal point. 

Dot Leader Tab:- Automatically place dot leaders (. . . .) between columns of 

designated text. The leaders lead the reader's eyes from text in the left column 

to text in the right column. 

Text Wrapping:- Positions text in relation to an inserted object (graphic). Text 

may appear above and below, around, behind, or in front of an object. 

Insert Features:-Various commands on the Insert menu are used to add page numbers, dates, 

headers,footers, and footnotes and to insert symbols, clip art, files, pictures, shapes, text boxes, 

and word art. 

Shapes:- Adds a variety of shapes (rectangles, stars, banners, arrows, flow chart 

symbols, etc.) to a document. 

Clip Art:- Drawings, pictures, sounds, and video clips can be inserted into 

documents. A collection of clip art files is provided with word processing 

software; additional clip art can be purchased or downloaded from the Internet. 
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Date :- Automatically inserts the date into a document. Some software contains 

an Update option that automatically replaces the previous date with the current 

date each time the document is opened or printed. 

Footnote and Endnote:- Identifies sources quoted or paraphrased in the text or gives 

extra information about the main text. Word processing software automatically 

positions and prints each footnote at the bottom of the same page as the reference to 

it. It prints endnotes on a separate page at the end of a report. When footnotes or 

endnotes are edited, added, or deleted, the software feature automatically makes the 

necessary changes in numbering, formatting, and page breaks. 

Header and Footer:- Adds text (such as a chapter title, date, filename, or name 

of a person or company) or graphic (a company logo, for example) in the top 

margin (header) or bottom margin (footer) of a page. Headers or footers often 

include page numbers. 

Page Numbers:- Places page numbers in a specified location on printed pages. 

Most software contains a variety of numbering styles from which to choose: 

Arabic numerals (1, 2, 3), lowercase Roman numerals (i, ii, iii), uppercase 

Roman numerals (I, II, III), uppercase letters (A, B, C), and lowercase letters 

(a,b,c). Numbers can be placed at the top or bottom of the page, and aligned at the 

left margin, center, or right margin.The Hide or Suppress option keeps the page number from 

appearing on a specified page. 

Text Boxes:- Frequently used for labels or callouts in a document. Once a text 

box is inserted in a document, it can be formatted, resized, and moved. 

Word Art:- Changes text into a graphic object. Most word processing software 

programs have a word art gallery that contains predefined styles such as curved or 

stretched text. 
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Formatting-Text and Document  

Formatting text in Microsoft Word involves tasks like bolding the text, italicizing it, and 

changing the font and size. The commands to perform all of these formatting tasks are found on 

the Home tab in the Font group. Select your text and then click on the required formatting button 

to see the effects. 

 

 

Alternatively, you can use the keyboard shortcuts for those commands. Here are the shortcuts for 

some of the more commonly used formatting commands: 

❖ Bold: ctrl-b 

❖ Italic: ctrl-I 

❖ Underline: ctrl-u 

❖ Font style. 

❖ Font size. 

❖ Font color.  

❖ Use super script and subscript option to change in text. 

❖ Fill color behind text using text highlighter color. 

❖ Using change case we can change the text style like sentence case, uppercase, lowercase & 

toggle case. 

In this way a lot of changing of text can be done in MS Word. 

Document formatting refers to the way a document is laid out on the page—the way it looks and 

is visually organized—and it addresses things like font selection, font size and presentation (like 

bold or italics), spacing, margins, alignment, columns, indentation, and lists. 

Word has two basic types of Word document formatting styles: Paragraph Styles - They apply to 

a minimum of an entire paragraph, and contain paragraph formatting (alignment, indents, etc.) 

and character formatting (font, color, etc.).  

There are other formatting by which formatting can be done in a document in the MS Word, they 

are as follows:- 
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Page Setup and Margin Formatting  

The settings of output page when it is printed on a printer are called page formatting. These 

include page size, page orientation, page margins, etc. Page formatting is defined in Page 

Setup under File menu. When Page Setup command is applied. 

Formatting Spacing  

The standard spacing format for a paper is double-spacing. Double-space the entire document, 

including the reference page. 

1. Select the Home tab.  

2. From the Paragraph menu, you may adjust the line spacing from the Line Spacing dropdown 

menu. 

 

Hanging Indent  

Select the text that requires a hanging indent OR create a hanging indent before typing the text. 

From the Home menu, click on the Paragraph command. This will bring up the Indents and 

Spacing tab . Under Indentation in the Special box, click on Hanging and OK. 

Styles 

A style is a pre-defined or user defined group of formatting options united under one common 

name which can be applied to a piece of text. Most of the time you use the 'normal' style to 

format text. 

In a style, there are stored all formatting options of a paragraph or of a piece of text such as: 

Font family:-The form of letters 

Font face:- Additional visual characteristics of letters such as bold, italic, underlined etc. 

Font size:- The size of letters defined in so-called points (pt). Normal body text has most of the 

time the size of 10 or 12 pt. 

Paragraph margins:- The distances to the left and right paper edge, to the previous and next 

paragraph, between the lines in the paragraph. 

Headings 

The best idea to get a structure in a text is to divide it into chapters, sections, subsections etc. 

Each of the sectioning parts starts with its heading - title.  
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There are 9 levels of pre-defined headings in Word. Each of them has a slightly different size and 

appearance. You should format the chapters with the highest level (heading 1), sections with the 

heading 2, subsections with the heading 3 etc. This way you have a clear hierarchical structure in 

your text which allows you to: 

o Change in a uniform way the appearance of chapter or section headings in the whole 

document 

o Effectively use the View option Outline  

o Automatically produce the Table of Contents etc. 

 

Lists 

Use lists to format the enumeration of similar elements such as: 

o Concepts 

o Key words 

o Presentation notes etc. 

Word supports two kinds of lists: 

1. Bulleted lists and 

2. Enumerated lists. 

 

Tables 

Beside lists, tables are a very powerful way of visual presentation of data sets. For example, all 

spreadsheet programs work with tables.  

Tables consist of cells organized in rows and columns. Each cell contains a data field. A row 

means a horizontal, a column a vertical grouping of cells.  

Tables are a more compact way of visualizing various types of information about several objects 

of the same kind.  

Automatic Table of Contents 

After you made proper structuring of your document using Headings, Word has the ability to 

make a Table of Contents automatically. The entries in a Table of Contents are at the same time 

hyperlinks to the referred headings. That means that a left mouse button click on an entry in the 

Table of Contents will put the insertion mark exactly on the beginning of the corresponding 

section heading in the text. 

Comments  

If you put specific information about any word, table, picture or a heading for this you can use 

the comment option in MS Word.  

https://www.lib.uom.gr/accelerate/ttu_en/ms_word_formatting.html#outline
https://www.lib.uom.gr/accelerate/ttu_en/ms_word_formatting.html#making_toc
https://www.lib.uom.gr/accelerate/ttu_en/ms_word_formatting.html#headings
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Sorting and Tables  

 

Sorting Information Word's sorting tool allows you to sort text a number of different ways in 

your document. You can sort tables, dates, paragraphs, and more with just a few clicks in Word. 

 

To sort a table in Word, click into the table to sort. Then click the “Layout” tab of the 

“Table Tools” contextual tab in the Ribbon. Then click the “Sort” button in the “Data” button 

group to open the “Sort” dialog box. You use this dialog box to sort the table information. 

 

You can sort a table in Word that is used for storing and organizing data. It is possible to sort a 

table in Word by one or more columns of data in the table. You can sort a table in Word both 

alphabetically or numerically. You can also sort column data in either ascending (A-Z, 1-9) or 

descending (Z-A, 9-1) order. 

            To sort a table in Word, click into the table to sort. Then click the “Layout” tab of the 

“Table Tools” contextual tab in the Ribbon. Then click the “Sort” button in the “Data” button 

group to open the “Sort” dialog box. You use this dialog box to sort the table information. 

 

            If your table has column headers, or titles, for each data column, you can sort the table 

using those names. To show the field names in the “Sort by” drop-down menus, select the 

“Header row” option. This option appears in the “My list has” section at the bottom of this dialog 

box. If you don’t have column headers, instead select the column number by which you want to 

sort the data. Select either the column names or numbers from the “Sort by” drop-down menus. 

 

            After choosing by which columns to sort, you then select the type of data in the column. 

Select the type of data contained in the column from the “Type:” and “Using:” drop-down 

menus. Your data type choices are text, number, or date. Then select in what order you want to 

sort the column’s data: “Ascending” or “Descending.” 

 

Sort a Table in Word 

1. To sort a table in Word, click into the table to sort. 

2. Then click the “Layout” tab of the “Table Tools” contextual tab in the Ribbon. 

3. Then click the “Sort” button in the “Data” button group to open the “Sort” dialog box. 

4. To show field names in the “Sort by” drop-downs for tables with column headers, select the 

“Header row” option. 

5. This option appears in the “My list has” section at the bottom of this dialog box. 

6. If you don’t have column headers, instead select the column number by which you want to 

sort the data. 



M.A. English Sem. 1st  Unit -2nd Computer Applications  ENG-VIII 

GCW, Narnaul 
21 

7. Select either the column names or numbers from the “Sort by” drop-down menus. 

8. After choosing by which columns to sort, you then select the type of data in the column. 

9. Select the type of data contained in the column from the “Type:” and “Using:” drop-down 

menus. Your data type choices are text, number, or date. 

10. Then select in what order you want to sort the column’s data. You can choose either 

“Ascending” or “Descending” order. 

11. To sort a table in Word by multiple columns, repeat steps 7 through 10 within the “Then by” 

sections. 

12. To perform the sort after deciding how to sort the table, click the “OK” button. 
 

Working with graphics in MS Word 

Microsoft Word allows to simply insert graphics in a document. Graphics are give life to the dull 

and boring text documents. Following types of graphics are used in Microsoft Word to make the 

document beautiful and attractive:- 

Text Box 

A text box is used to add a piece of text at any place in a document. For example, a text box may 

be used to add text in margins of a page, in the center of the page, etc. To enter a text box: 

• On the Drawing toolbar, click Text Box. 

• Click or drag in the document where text box is to be inserted. 

Types of Graphics in MS Word 

There are two types of graphics that are usually added in a word processor. These are bitmap 

graphics and vector graphics. Bitmap graphics are made up of pixels. These can be thought of 

as painted pictures. Vector graphics are made up of lines and curves. These can be thought of as 

drawings. 

Bitmap Graphics 

Bitmap graphics are added to a document by selecting Insert/Picture option from the menu bar. 

Pictures can be inserted from a file, Clip Art, scanner. Charts and Word Art can also be added as 

pictures. When a picture is selected, the picture tool bar appears. This toolbar can also be 

accessed by selecting View>Toolbars>Picture. The picture toolbar is used to change shape, 

color, brightness, size, etc. of the selected picture. 

Vector Graphics  

Vector graphics consist of lines, curves, etc. These are drawn using the Drawing toolbar. 

Clicking the Drawing icon W in the standard toolbar displays the Drawing Toolbar. 
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The Drawing toolbar contains buttons for creating and inserting different graphics, like lines, 

circles, rectangles, text boxes, WordArt and Auto shapes. It also has tools for editing and 

formatting these objects. Various tools for editing include fill tool, line-style tool, shadow and 3-

D options. The Draw button at the leftmost comer of the drawing toolbar is used to select and 

draw drawing objects. The Drawing toolbar also provides a collection of predefined objects 

called Auto shapes that are commonly used in documents. Following figure shows some of these 

shapes. To draw a vector graphics: 

1. Click drawing icon to display drawing toolbar. 

2. Click on Select Object icon. 

3. The mouse pointer will change. 

4. Click the mouse on a drawing object, for example click on line object to select it. The mouse 

pointer will change to a cross-hair shape. 

5. Click and draw the object. 

 

WordArt Graphics:  

WordArt is a small program that runs in the Word environment. It is used to turn ordinary words 

into graphics objects. It can convert text into a variety of shapes, stretch letters, rotate words, add 

shading, colors, borders and shadows to text. A WordArt image is just like any other graphic 

object in Word. 
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Once created, it can be edited by using the standard graphics editing tools like move, copy, re-

size, crop, etc. 

Inserting a Word Art Object 

To insert a WordArt object: 

1. Click the WordArt icon in the Drawing Toolbar, or choose WordArt from the Picture 

submenu in the Insert menu. The WordArt Gallery dialog box will appear. 

2. Choose the text effect that is to be applied and click OK. This will display Edit WordArt Text 

window. 

3. Choose the options for Font type, style, and size. 

4. Enter the text to which graphic effects are to be applied. 

5. Click OK and WordArt will create the text effect and place it at the insertion point. 
 

Introduction to mail merge 

Mail merge is a feature within most data processing applications that enables users to send a 

similar letter or document to multiple recipients. It enables connecting a single form template 

with a data source that contains information about the recipient's name, address and other 

predefined and supported data. 

Steps to use mail merge 

1. In a blank Microsoft Word document, click on the Mailings tab, and in the Start Mail 

Merge group, click Start Mail Merge. 

 

 

2. Click Step-by-Step Mail Merge Wizard. 
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3. Select your document type. In this demo we will select Letters. Click Next: Starting 

document. 

 

4. Select the starting document. In this demo we will use the current (blank) document. 

Select Use the current document and then click Next: Select recipients. 
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• Note that selecting Start from existing document (which we are not doing in this demo) 

changes the view and gives you the option to choose your document. After you choose it, the 

Mail Merge Wizard reverts to Use the current document. 

 

5. Select recipients. In this demo we will create a new list, so select Type a new list and then 

click Create. 

 

• Create a list by adding data in the New Address List dialog box and clicking OK. 
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• Save the list. 

• Note that now that a list has been created, the Mail Merge Wizard reverts to Use an existing 

list and you have the option to edit the recipient list. 

 

• Selecting Edit recipient list opens up the Mail Merge Recipients dialog box, where you can 

edit the list and select or unselect records. Click OK to accept the list as is. 
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• Click Next: Write your letter. 

 

6. Write the letter and add custom fields. 

• Click Address block to add the recipients' addresses at the top of the document. 
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• In the Insert Address Block dialog box, check or uncheck boxes and select options on the left 

until the address appears the way you want it to. 

 

• Note that you can use Match Fields to correct any problems. Clicking Match Fields opens up 

the Match Fields dialog box, in which you can associate the fields from your list with the 

fields required by the wizard. 

 

 



M.A. English Sem. 1st  Unit -2nd Computer Applications  ENG-VIII 

GCW, Narnaul 
29 

7. Press Enter on your keyboard and click Greeting line... to enter a greeting. 

 

8. In the Insert Greeting Line dialog box, choose the greeting line format by clicking the drop-

down arrows and selecting the options of your choice, and then click OK. 
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9. Note that the address block and greeting line are surrounded by chevrons (« »). Write a short 

letter and click Next: Preview your letters. 

 

• Preview your letter and click Next: Complete the merge. 
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• Click Print to print your letters or Edit individual letters to further personalize some or all of 

the letters. 

 

 

 

Advantages of mail merge 

 

Mail merge is one great use of Microsoft word that users need to know how to use. What though 

is mail merge? Mail merge is the method of creating customized letters for form letters that allow 

letters sent to a group of people to be read as individual letters or mails. 

This method saves time and also labor by producing a large number of mails at the same time. 

Here are some other advantages of using the mail merge feature: 

• It is simple and easy to use 

With mail merge, you can easily create and customize templates files. So instead of creating one 

letter at a time which is going to be very tiring especially if you are going to send out a lot of 

letters, you can actually have your letters ready in no time when you use the mail merge feature. 

• You can edit as you like 

With the mail merge feature your editing and customization is only limited to what you can do. 

This means that you can add tables, colors, graphics and all other editing elements that are at 
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your disposal. The customization that you make to the main document also appears in all other 

documents, so you don’t have to do it all again. 

• Conditional formatting or options 

Along with the ability to edit or customize documents according to the need of the recipient you 

can also do more to increase the how formatted the document is. This means with conditional 

formatting you can change how mail merge handles your data based on the conditions that you 

provide. 

Say for example, you want to send out letters to certain people who contributed for a fund raiser 

in your company. You can set up a field that allows the mail merge process to actually skip a 

record if it does not reach up to a certain numerical value, while allowing you to send a message 

to people that you want to. 

• It makes your work neater and professional 

You can break down your source data into smaller useful units of information which makes you 

to be able to be flexible with your input information. This allows you to make your work look 

neat and professional at the same time. 

 

Disadvantages of Mail Merge 

 

• Mail merging can have complications, for example moving the data file, renaming fields etc. 

can cause the merge to fail as the word processor program cannot find the data sources it 

needs. 

• Mail merging makes it very easy to create vast amounts of junk mail. 

• Mail merged letters can lack a personal touch because the only individual part in a mail 

merged document is the data merged from the database. 
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Definition - What does Microsoft Excel mean? 

Def: - Microsoft Excel is a software program produced by Microsoft that allows users to organize, 

format and calculate data with formulas using a spreadsheet system. This software is part of the 

Microsoft Office suite and is compatible with other applications in the Office suite. 

 

Def: - Excel is a handy software that can be used to store and organize many data sets. Using its 

features and formulas, you can also use the tool to make sense of your data. For example, you could 

use a spreadsheet to track data and automatically see sums averages and totals. 

Excel Basics 

If you're just starting out with Excel, there are a few basic commands that we suggest you become 

familiar with. These are things like: 

• Creating a new spreadsheet.  

• Executing basic computations in a spreadsheet, like adding, subtracting, multiplying, and   
dividing in a spreadsheet. 

• Writing and formatting column text and titles. 

• Excel's auto-fill features. 

• Adding or deleting single columns, rows, and spreadsheets. Below, we'll get into how to add 
things like multiple columns and rows. 

• Keeping column and row titles visible as you scroll past them in a spreadsheet, so that you know 
what data you're filling as you move further down the document. 

Feature’s of MS Excel 2007 

In Excel 2007, more is truly better. Microsoft has increased the number of columns per spreadsheet 

(and per PivotTable) to 16,384 (up from 256) and the number of rows to 1,048,576 (up from 

65,536). Other limits have been also expanded: Text cells can now contain more than 32,000 

characters (up from 255). 

Chances are you'll never reach other new limits: PivotTables can manipulate more than 16,000 fields 

(up from an already generous 255), and formulas can now refer to up to 8,000 cells (memory 

permitting), so it's fortunate that Excel 2007 lets you drag the corner of the formula bar to expand it. 

Excel 2007's memory manager can handle 2GB (double the amount in Excel 2003), so calculations 

execute faster. The new version also takes advantage of dual-core processors and multithreaded chip 

sets, so if you're lucky enough to be running it on a machine with either feature, expect a noticeable 

speed boost. 

New Visualization Tools 

Charts and graphs now support 16 million colors, and improved color support is evident throughout 

this version, especially in several new visual tools for highlighting data. For example, in Excel 2007 

you can use conditional formatting to set the background color of a cell or use a colored bar (called a 

data bar) -- the length corresponds to the cell's value. 
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You can also add icons to cells based on their value, giving your worksheet a dashboard-like quality. 

For example, assigning traffic-light icons to a range of cells is a snap, and Excel's built-in logic 

assigns colored circles based on the value of the cell: green for the highest third, yellow for the 

middle third and red for the bottom third. 

 
You can add colored bars to indicate the value in a cell (left) or apply a three-icon set to indicate 

which third data falls into (right); a red traffic light indicates the cell is in the lowest third of all 

values in the range. 

There are in fact many variations on these built in to Excel 2007, but if you can’t find one that suits 

you can always set up your own rules. (Conditional Formatting > New Rule) 

 
 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

Better Sorting and Filtering 

Sorting data -- previously limited to three levels -- has been expanded to 64 levels, while you can 

still sort data based on values (Top to Bottom or A - Z, etc) you can also sort by font, colour or icon 
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used with conditional formatting. Thus, you can display all your green traffic lit cells together, 

followed by the yellow lights, then the red. 

 
Other visualization tools remove the need for complicated macros or formulas. New conditional 

formatting options let you highlight duplicates, unique values, the top/bottom 10%, values above or 

below the average, cells less than or greater than a specified value, or cells within a range, 

highlighting cells containing values between 1 and 10, for instance). 

If you don't need to see all values, the vastly improved Filter feature puts check boxes (for up to 

1,000 values) in a pull-down list, allowing you to easily pick multiple values to display. Likewise, 

the new Remove Duplicates feature hides rows based on the duplicate values in columns you 

specify. 
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Styles and Themes 

Styles 

Styles is a formatting tool from previous versions of Excel that is now available using a "gallery" 

interface introduced in Office 2007. You can quickly apply a collection of settings, from the font 

used to the background color and border style to cells, tables and PivotTables. As you mouse 

over the choices, Excel 2007 applies each style to your selection so you can preview the effect 

without making the change permanent. 

One particularly noteworthy improvement to formatting is how Styles now respond to changes 

within your worksheet. In Excel 2003, you could apply a "green bar" effect so that the 

background color in rows alternated between green and white. However, once you added a row, 

the pattern was interrupted, and you needed to reapply the AutoFormat. In Excel 2007, that same 

pattern is adjusted whenever you add one or more rows. (Styles are equally smart when you add 

columns, for patterns that alternate between columns.) Styles will even adjust when you filter or 

hide rows or columns. 

Themes 

Themes are a feature new to Office 2007, they are style collections that include a color scheme, 

font, fill effects and more. Shared by several Office 2007 applications, themes can be applied to 

charts, tables and PivotTables in Excel, giving your work a consistent look and feel. That's 

especially useful when you're creating a chart that you want to copy to PowerPoint or Word. 
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To use Themes, select the Page Layout tab and click the Themes button to choose a new theme. 

You can also customize any theme or create new ones. One important limitation is that Themes 

only work if you're using the new Office XML format; they won't work on old-style .xls files. 

Charts 

The Ribbon interface also makes it more enjoyable to work with charts. Excel's charts have a 

whole new look, thanks to the new graphics engine in all Office 2007 applications. The layouts 

use different color palettes and fonts, but the important difference is the ability to more easily 

apply graphical effects, such as bevels and shadows, to individual elements (such as columns or 

pie slices). 

 

The Ribbon interface has a Chart Tools group (with tabs for Design, Layout and Format) to put 

more charting options at your fingertips and eliminate most of the right-clicking you had to do to 

adjust charts in previous versions: switching rows and columns, controlling gridlines and axes, 

and adding trend lines. 

 

Table Tools 

Excel's new table features make it less likely you'll have inconsistent formulas. Once you identify 

a contiguous range of cells as a table, Excel provides calculated columns. For example, if you 

add a column to the right of your table and enter a formula in any row, the formula will be copied 

to all cells in that new column, saving the time of executing a copy/paste command. 
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Even smarter, add a row and Excel is sure to include it in a total on the bottom row. (In previous 

versions of Excel, adding a row at the top or bottom of a range meant you risked omitting cells in 

that row from the sum formula.) 

 

Furthermore, options on the Table Tools Design context-sensitive tab let you toggle the 

formatting of the first column or the first row. One click and you can add a Total row (though 

Excel lacks a similar command to add a Total column), then change what each column in that 

row computes (total, average, minimum and so on). 

In addition, as you scroll down through a lengthy table, Excel replaces the column headings (the 

gray boxes with A/B/C above the columns) with values from the table's header row -- a subtle 

improvement, to be sure, but it's a more efficient technique than having to freeze rows to see 

column headings. 

Finally, the new Table Gallery makes it easy to select and apply a sophisticated look. 

Pivot Tables 

Among the notable improvements in Excel are tools to make existing features easier to use. Take 

PivotTables, for example. (For the uninitiated, PivotTables allow you to view your data 
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differently -- think "slice and dice." For example, you can summarize sales by agent by month or, 

with a simple drag-and-drop motion, summarize sales by month and within month by agent.) 

In Excel 2007, you still set up PivotTables using a wizard, which is slightly changed from Excel 

2003. However, once you have a PivotTable defined, manipulating it is considerably easier. 

Instead of dragging and dropping elements within the table itself, you can use the wizard to make 

choices -- checking boxes to select which fields to display or choose sorting options, for 

example. Excel 2007 makes it easier to switch columns and rows, filter values, and use or hide 

field names. In addition, conditional formatting (those data bars or traffic lights we mentioned) 

can be applied to cells displayed in PivotTables. 

The Most Common Formatting Commands 

There are many types of formatting that can be applied to Microsoft Excel worksheets. The most 
commonly used formatting commands show up on the Home tab in three groups: 

1. The Font Group. The font group commands change the appearance of text within a cell or of 

the cell itself. 

2. The Alignment Group. The alignment group commands change the position of text within a 
cell or cells. 
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3. The Number Group. The number group commands change the format of numbers and dates 
within a cell. 

Formatting changes can be applied to a whole worksheet, a range of cells within a worksheet, 

individual cells, and sometimes even text within a cell. 

 

Excel Formatting  

As well as giving your spreadsheet a professional look, the use of Excel formatting can provide 

essential information that influences the way a user interprets the data in the spreadsheet. 

This is particularly the case with Excel numbers. 

As dates, time, percentages and currency values are all stored as numeric values in Excel, the 

user often has to rely of the formatting of these numbers to understand what they represent. 

For example, a cell containing the data value 0.5 could represent any of the following: 

• The time 12:00 hrs 
• The date and time 01-Jan-2020 12:00 
• The currency value $0.50 
• The percentage value 50% 
• The simple number 0.5 

The spreadsheet below shows different ways of formatting Excel cells containing numeric 

values. 

  A B C 

1   Formatted Value Underlying Value 

2 A number formatted as a percentage: 59% 0.59 

3 A number formatted as a currency: $54.27 54.27 

4 A number formatted as a date: 01 August 2019 39661 

5 A number formatted as a time: 12:27 PM 0.51875 

6 A number formatted as a fraction: 1 3/4 1.75 

 

How to Change Formatting in Excel 

To format data in Excel cells, you first need to select the cells to be formatted. Some of the more 

popular formatting options can then be accessed directly from the Home tab of the ribbon  
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However, for the full menu of formatting options, you will need to use the 'Format Cells' dialog 
box, which can be accessed by any of the following methods: 

• Right-click on the selected cell or range and select the Format Cells ... option from the right-
click menu 
or 

• Press Ctrl + 1   (i.e. Select the Ctrl key and while holding this down, select the "1" (one) key) 

or  

 
• Click on the dialog box launcher in the Number grouping within the Home tab of the Excel 
ribbon (see right). 

 
 

The 'Format Cells' dialog box is shown on the left. 

Make sure that the Number tab at the top of the dialog box is selected then, from 

the Category options (on the left of the dialog box), select the Excel formatting type that you 
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want to apply to your cell (e.g. Number, Percentage, Date, etc). 

When you select a category, you may be presented with further options on the right hand side of 

the dialog box, which you can use to specify your formatting style. 

Once you have specified the formatting details that you require, click OK to close the dialog box. 

Note that the listed formats will only work with numbers, so if you apply a date format to a cell 

containing text, the appearance of the cell will remain unchanged. 

Excel Date Format 

Excel provides several standard date formats that you can apply to cells containing date values. 

These can be accessed in different ways (see below). 

However, if none of the standard date formats are satisfactory, Excel also allows you to define 

your own custom date format. 

In recent versions of Excel (Excel 2007 and later) a selection of standard formats, including some 

date formats, are available via the drop-down box in the 'Number' grouping on the Home tab of 

the ribbon. 

To apply a standard date format to the cell(s) of your spreadsheet, simply select the cell(s) to be 

formatted and click on the format cells drop-down box. You will then be presented with several 

formats which, if selected, will be applied to the current selected cell(s). 

The image on the right shows two Excel date format options that are available in the drop-down 

menu when a PC is set up for US times. 

The standard date formats in your version of Excel may be different, depending on the settings 

on your computer. 

• Excel Custom Number Formatting 

• Merge Cells 

• Wrap Text In Excel 

• Conditional Formatting 

Excel Functions 

Excel Functions written in layman's terms and in a language we all understand. No computer 

speaks just plain English and practical examples of Excel functions used in formulas. Before we 

dive into the examples I want to cover some terminology that I’ll be using. 

 

Anatomy of an Excel Function 

Excel functions comprise of the function name and arguments, as you can see in the example 
below:  
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The arguments are the inputs required by the function and are enclosed in parentheses. 

Arguments surrounded by square brackets are optional. For example, the VLOOKUP argument; 

‘range_lookup’, is optional. 

In some cases, if you omit optional arguments Excel will apply a default. This default will be 

specific to each function. 

Excel Functions Library 

Click the links below to jump to a section. 

• Array Functions 
• Database Functions 
• Date and Time Functions 
• Engineering Functions 
• Financial Functions 
• Information Functions 
• Logical Functions 
• Lookup and Reference Functions 
• Math Functions 
• Statistical Functions 
• Text Functions 

Array Functions 

FILTER  Filter cells based on criteria. 

RANDARRAY Returns an array of random numbers between 0 

and 1. 

SEQUENCE Returns list of sequential numbers that 

increment as specified. 

SORT Sort cells or arrays in ascending or descending 

order. 

https://www.myonlinetraininghub.com/excel-functions#Information
https://www.myonlinetraininghub.com/excel-functions#Logical
https://www.myonlinetraininghub.com/excel-functions#Lookup
https://www.myonlinetraininghub.com/excel-functions#Math
https://www.myonlinetraininghub.com/excel-functions#Statistical
https://www.myonlinetraininghub.com/excel-functions#Text
https://www.myonlinetraininghub.com/excel-functions/excel-filter-function
https://www.myonlinetraininghub.com/excel-randarray-function
https://www.myonlinetraininghub.com/excel-sequence-function
https://www.myonlinetraininghub.com/excel-functions/excel-sort-function
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SORTBY Sort a range or arrays based on criteria. 

UNIQUE  Extract a unique or distinct list from a range or 

array. 

Database Functions 

DSUM Sum a range based on criteria. Alternative to 

SUMIFS. 

Date and Time Functions 

DATE  Build a date with separate year, month and day 

values. 

DATEDIF Find the difference between two dates in days, 

months or years. 

DATEVALUE  Convert dates stored as text to a date Excel can 

use in formulas etc. 

DAY  Returns the day of the month between 1 and 31 

from a date or text. 

DAYS  Returns the number of whole days between two 

date serial numbers. It ignores time portions 

where included. 

DAYS360 Returns the number of days between two date 

serial numbers based on a 360-day year, or 

twelve 30-day months. 

EDATE  Returns the same date of the month, n months 

before or after the specified date. 

https://www.myonlinetraininghub.com/excel-sortby-function
https://www.myonlinetraininghub.com/excel-functions/excel-unique-function
https://www.myonlinetraininghub.com/excel-date-function
https://www.myonlinetraininghub.com/secret-excel-function-datedif
https://www.myonlinetraininghub.com/excel-functions/excel-datevalue-function
https://www.myonlinetraininghub.com/excel-functions/excel-day-function
https://www.myonlinetraininghub.com/excel-functions/excel-days-function
https://www.myonlinetraininghub.com/excel-functions/excel-days360-function
https://www.myonlinetraininghub.com/excel-edate-function
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EOMONTH  Returns the last day of the month, n months 

before or after the specified date. 

HOUR Returns the hour integer ranging from 0 to 24, 

from a time. 

ISOWEEKNUM  Returns the week number of a date serial 

number. The first Monday of the year marks 

the start of week 1. 

MINUTE  Returns the minute, ranging from 0 to 59, from 

a time. 

MONTH  Returns the month number, between 1 and 12, 

from a date. 

NETWORKDAYS Returns the number of whole working days 

between two date serial numbers, excluding 

weekends. 

NETWORKDAYS.INTL  Returns the number of whole working days 

between two date serial numbers, excluding 

weekend days of your choice. 

NOW  Returns the current date and time from your 

computer clock. 

SECOND Returns the seconds, ranging from 0 to 59, 

from a time. 

TIME  Build a time value by entering separate hour, 

minute and second values. 

TIMEVALUE  Convert times stored as text to a time Excel can 

https://www.myonlinetraininghub.com/excel-eomonth-function
https://www.myonlinetraininghub.com/excel-functions/excel-hour-function
https://www.myonlinetraininghub.com/?page_id=49183&preview=true
https://www.myonlinetraininghub.com/excel-functions/excel-minute-function
https://www.myonlinetraininghub.com/excel-functions/excel-month-function
https://www.myonlinetraininghub.com/excel-networkdays-function
https://www.myonlinetraininghub.com/excel-networkdays-intl-function
https://www.myonlinetraininghub.com/excel-functions/excel-now-function
https://www.myonlinetraininghub.com/excel-functions/excel-second-function
https://www.myonlinetraininghub.com/excel-time-function
https://www.myonlinetraininghub.com/excel-functions/excel-timevalue-function
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use in formulas etc. 

TODAY  Returns the current date serial number from 

your computer clock. 

WEEKDAY  Returns the day number of the week from a 

date serial number. The default ranges from 1 

for Sunday, through to 7 for Saturday. 

WEEKNUM  Returns an integer representing the week 

number (from 1 to 54) of the year from a date 

serial number. 

WORKDAY  Returns the day number of the week from a 

date serial number. The default return type 

ranges from 1 for Sunday to 7 for Saturday. 

WORKDAY.INTL  Returns a date serial number that is the 

specified number of working days before or 

after the start date. 

YEAR Returns the year as an integer between 1900 

and 9999, from a date. 

YEARFRAC Calculates the fraction of the year represented 

by the number of whole days between two 

dates. 

 

Engineering Functions 

CONVERT Converts inches to centimetres, pounds to 

grams etc. 

 

 

https://www.myonlinetraininghub.com/excel-functions/excel-today-function
https://www.myonlinetraininghub.com/excel-functions/excel-weekday-function
https://www.myonlinetraininghub.com/excel-functions/excel-weeknum-function
https://www.myonlinetraininghub.com/excel-functions/excel-workday-function
https://www.myonlinetraininghub.com/excel-functions/excel-workday-intl-function
https://www.myonlinetraininghub.com/excel-functions/excel-year-function
https://www.myonlinetraininghub.com/excel-functions/excel-yearfrac-function
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Financial Functions 

ACCRINT  Returns the accrued interest that gets paid 

periodically. 

EFFECT  Returns the effective annual interest rate, from 

the nominal annual interest rate (APR). 

FV  Calculate the future value of an investment. 

NPER  Calculates the number of periods to reach an 

investment goal. 

PMT Returns the regular and constant repayments 

for a loan or mortgage required to reduce the 

balance to zero, or an amount you specify. 

Information Functions 

CELL Returns information about the formatting, 

contents or location of a cell. 

N Converts a value to a number, but it's clever 

uses is where it shines. 

SHEET Returns the sheet number of a cell reference. 

SHEETS Returns the count of sheets in a given 

reference. 

Logical Functions 

IF Test for a condition to be met and return a 

result if true, or false. 

https://www.myonlinetraininghub.com/excel-accrint-function
https://www.myonlinetraininghub.com/excel-functions/excel-effect-function
https://www.myonlinetraininghub.com/how-to-calculate-interest-on-savings-in-excel
https://www.myonlinetraininghub.com/calculate-how-long-to-make-1m-with-nper
https://www.myonlinetraininghub.com/excel-functions/excel-pmt-function
https://www.myonlinetraininghub.com/excel-cell-function
https://www.myonlinetraininghub.com/excel-sheet-function
https://www.myonlinetraininghub.com/excel-sheets-function
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IFS  Allows for multiple logical tests without the 

need for nesting. New in Excel 2016. 

IFERROR Hide or handle formula errors. 

SWITCH  Looks up a value in a list of values, and returns 

the result corresponding to the first matching 

value. New in Excel 2016. 

XOR Performs an 'exclusive or' test on an array, 

range or one or more expressions. New in 

Excel 2013. 

Lookup and Reference Functions 

ADDRESS  Return a text value of a cell address. 

CHOOSE Return a value from a list based on the position 

specified. 

FILTER  Filter cells based on criteria. 

GETPIVOTDATA  Get values from a PivotTable. 

HLOOKUP  Look up a value in the top row of a table. 

HYPERLINK  Insert links to internal or external locations. 

INDEX  lookup a range of cells and return a single 

value, an array of values, a reference to a cell 

or range of cells. 

INDIRECT  Convert text into a cell reference. 

https://www.myonlinetraininghub.com/excel-ifs-function
https://www.myonlinetraininghub.com/excel-iferror-puts-an-end-to-messy-workarounds
https://www.myonlinetraininghub.com/excel-switch-function
https://www.myonlinetraininghub.com/excel-xor-function
https://www.myonlinetraininghub.com/excel-address-function
https://www.myonlinetraininghub.com/excel-choose-function
https://www.myonlinetraininghub.com/excel-filter-function
https://www.myonlinetraininghub.com/excel-getpivotdata-function
https://www.myonlinetraininghub.com/excel-hlookup-formulas-explained
https://www.myonlinetraininghub.com/excel-factor-18-dynamic-hyperlinks-and-the-magic
https://www.myonlinetraininghub.com/excel-functions/excel-index-function
https://www.myonlinetraininghub.com/excel-indirect-function
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MATCH Returns the relative position of a value. The 

lookup range can take the shape of a row or 

column. 

OFFSET  Return a range of cells offset from a starting 

cell. 

SORT Sort cells or arrays in ascending or descending 

order. 

SORTBY Sort cells or arrays based on criteria. 

UNIQUE  Extract a unique or distinct list from a range or 

array. 

VLOOKUP  Look up a value in the first column of a table. 

XLOOKUP  Like VLOOKUP but much better! 

Math Functions 

AGGREGATE  Returns an aggregate (sum, average, min, max, 

count etc.) of a list or database. 

MOD Returns the remainder after a number is divided 

by a divisor. 

MROUND  Rounds numbers to the nearest multiple. 

RANDARRAY Returns an array of random numbers between 0 

and 1. 

SEQUENCE Returns list of sequential numbers that 

increment as specified. 

https://www.myonlinetraininghub.com/excel-functions/excel-match-function
https://www.myonlinetraininghub.com/excel-offset-function-explained
https://www.myonlinetraininghub.com/excel-sort-function
https://www.myonlinetraininghub.com/excel-sortby-function
https://www.myonlinetraininghub.com/excel-unique-function
https://www.myonlinetraininghub.com/excel-vlookup-formulas-explained
https://www.myonlinetraininghub.com/excel-xlookup-function
https://www.myonlinetraininghub.com/excel-aggregate-function
https://www.myonlinetraininghub.com/excel-mod-function
https://www.myonlinetraininghub.com/excel-mround-function
https://www.myonlinetraininghub.com/excel-randarray-function
https://www.myonlinetraininghub.com/excel-sequence-function
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SIGN  Returns the sign of a number. 

SUBTOTAL Choose the aggregation method e.g. SUM, 

AVERAGE, COUNT etc. and ignore or include 

filtered rows. 

SUMPRODUCT Much more than just multiplying arrays and 

returning the sum of the results. 

Statistical Functions 

FORECAST Forecast future values using linear regression. 

FORECAST.ETS  Forecast future values using Exponential 

Triple Smoothing and machine learning. New 

in Excel 2016 

FORECAST.ETS.CONFINT  Returns a confidence interval for forecasted 

values. New in Excel 2016 

FORECAST.LINEAR  Forecast future values using linear regression. 

New in Excel 2016, replacing the FORECAST 

function. 

RANK Return a rank for a dataset. Includes 

RANK.EQ and RANK.AVG 

Text Functions 

CHAR  Returns a character based on its Windows-1252 

character number. 

CLEAN Removes non-printing characters from text. 

CONCATENATE  Joins text from separate cells together. 

https://www.myonlinetraininghub.com/excel-sign-function
https://www.myonlinetraininghub.com/excel-subtotal-formula-explained
https://www.myonlinetraininghub.com/excel-sumproduct-an-alternative-to-sumifs
https://www.myonlinetraininghub.com/excel-functions/excel-forecast-function
https://www.myonlinetraininghub.com/excel-functions/excel-forecast-ets-function
https://www.myonlinetraininghub.com/excel-functions/excel-forecast-ets-confint-function
https://www.myonlinetraininghub.com/excel-functions/excel-forecast-linear-function
https://www.myonlinetraininghub.com/excel-rank-rank-avg-and-rank-eq-functions
https://www.myonlinetraininghub.com/excel-functions/excel-char-function
https://www.myonlinetraininghub.com/excel-clean-formula
https://www.myonlinetraininghub.com/how-to-join-text-together-in-excel-using-concatenate-and
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SUBSTITUTE  Replaces new text for old text in a text string. 

T Checks whether a value is text, and returns the 

text if it is, otherwise returns a blank. 

TEXT Converts numbers to text in the format you 

specify. 

TEXTJOIN  Joins text together and can ignore empty cells. 

New in Excel 2019. 

TRIM  Remove the excess spaces from text, except for 

single spaces between words. 

Excel Formula 

A formula is an expression telling the computer what mathematical operation to perform upon a 

specific value. When referring to computer software, formulas are most often used in spreadsheet 

programs, such as Microsoft Excel. 

Formulas in Excel are used to perform calculations or other actions on data entered into the 

formula and/or stored in program files. 

They can range from basic mathematical operations, such as addition and subtraction, to complex 

engineering and statistical calculations.  

Formulas are great for working out “what if” scenarios that compare calculations based on 

changing data. Once the formula is entered, you need only change the amounts to be calculated. 

You don’t have to keep entering “plus this" or “minus that” as you do with a regular calculator. 

Formulas Start With the Equal Sign 

Formulas begin with an equal ( = ) sign and, for the most part, are entered into the worksheet 

cell(s) where you want the results or answer to appear. 

For example, if the formula =5 + 4 - 6 is entered into cell A1, the value 3 appears in that location. 

When cell A1 is selected, the formula displays in the formula bar above the worksheet. 

 

 

https://www.myonlinetraininghub.com/excel-substitute-formula
https://www.myonlinetraininghub.com/microsoft-excel-t-function
https://www.myonlinetraininghub.com/excel-text-function
https://www.myonlinetraininghub.com/excel-textjoin-function
https://www.myonlinetraininghub.com/excel-trim-function-removes-spaces-from-text
https://www.lifewire.com/formula-bar-fx-bar-3123846
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Formula Breakdown 

A formula can also contain any or all of the following: 

• Values 
• Constants 
• Cell references 
• Functions 
• Operators 

Values 

Values in formulas are not just restricted to numbers but can also include: 

• Dates 
• Text: Words surrounded by quotation marks ( " ") 
• Boolean values: TRUE or FALSE only 

Formula Constants 

A constant is a value that does not change and is not calculated. Although constants can be well-

known ones such as Pi ( Π ), the ratio of a circle's circumference to its diameter, they can also be 

any value, such as a tax rate or a specific date, which changes infrequently. 

Cell References in Formulas 

Cell references, such as A1 or H34, indicate the location of data in a worksheet. Rather than enter 

data directly into a formula, it is better to enter the data into worksheet cells and then enter the 

cell references to the location of the data into the formula. 

The advantages of this are that: 

• If you later change your data, the formula automatically updates to show the new result. 
• In certain instances, using cell references makes it possible to copy formulas from one 

location to another in a worksheet. 

To simplify entering multiple contiguous cell references into a formula, they can be entered as 

a range that just indicates the start and end points. For example, the references A1, A2, A3 can be 

written as the range A1:A3. 

To simplify things even further, frequently used ranges can be given a name that can be entered 

into formulas. 

 

https://www.lifewire.com/description-of-range-3123975
https://www.lifewire.com/define-and-edit-named-range-in-excel-4178633
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Functions: Built-in Formulas 

Excel also contains a number of built-in formulas called functions. 

Functions make it easier to carry out: 

• Commonly performed tasks, such as adding up columns or rows of numbers with 
the SUM function. 

• Long or complex operations, such as finding specific information with 
the VLOOKUP function. 

Formula Operators 

An arithmetic or mathematical operator is the symbol or sign that represents an arithmetic 

operation in an Excel formula. 

Operators specify the type of calculation being carried out by the formula. 

Types of operators 

The different types of calculation operators that can be used in formulas include: 

• Arithmetic: Used for basic math, such as addition and subtraction. 
• Comparison 
• Text concatenation 

Arithmetic Operators 

Some of the arithmetic operators, such as the ones for addition and subtraction, are the same as 

those used in hand-written formulas. Arithmetic operators for multiplication, division, and 

exponents are different. 

The arithmetic operators are: 

• Subtraction: Minus sign (-) 
• Addition: Plus sign ( + ) 
• Division: Forward slash ( / ) 
• Multiplication: Asterisk ( * ) 
• Exponentiation: Caret ( ^ ) 

If more than one operator is used in a formula, there is a specific order of operations that Excel 

follows in deciding which operation occurs first. 
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Comparison Operators 

A comparison operator carries out a comparison between two values in the formula and the result 

of that comparison is either TRUE or FALSE. 

There are six comparison operators: 

• Equals ( = )  
• Less than ( < )  
• Less than or equal to ( < = )  
• Greater than ( > )  
• Greater than or equal to ( > = )  
• Not equal to ( < > ) 

The AND and OR functions are examples of formulas that use comparison operators. 

Concatenation Operator 

Concatenation means to join things together and the concatenation operator is the ampersand 
(&). It can be used for joining multiple ranges of data in a formula. 

An example of this would be  

{=INDEX (D6:F11, MATCH (D3 & E3, D6:D11 & E6:E11, 0), 3)} 

where the concatenation operator is used to combine multiple data ranges in a lookup formula 
using Excel's INDEX and MATCH functions. 

Seven Basic Excel Formulas For Your Workflow 

• SUM. The SUM function. The function will sum up cells that are supplied as multiple 
arguments. ... 

• AVERAGE. The AVERAGE function. ... 

• COUNT. The COUNT function. ... 

• COUNTA. Like the COUNT function, COUNTA. ... 

• IF. The IF function. ... 

• TRIM. The TRIM function. ... 

• MAX & MIN. The MAX. 

 

Define chart and its features 

A chart is a powerful tool that allows you to visually display data in a variety of 

different chart formats such as Bar, Column, Pie, Line, Area, Doughnut, Scatter, Surface, or 

Radar charts. With Excel, it is easy to create a chart. Here are some of the types of charts that you 
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can create in Excel. 

Microsoft Office's Excel application allows users to store, model and manipulate data sets. Excel 

spreadsheets organize this data into worksheets, each with a number of rows and columns. Each 

row or column has one or more cells, with each cell holding a single data value. Excel provides a 

range of automated functions for working with these stored data values, including the chart 

function. Once data is stored in an Excel spreadsheet, anyone with access to that spreadsheet can 

manipulate the data in order to analyze and communicate its meaning. The charting function can 

be a key element in these processes. 

 

Advantages of Charts 

Excel charts allow spreadsheet administrators to create visualizations of data sets. By 

highlighting a set of data within an Excel spreadsheet and feeding it into the charting tool, users 

can create various types of charts in which the data is displayed in a graphical way. This can aid 

understanding of a data set, as well as communication of it, with Excel charts suitable for use 

within management or corporate presentations. 

A chart can create a clearer picture of a set of data values than a table with rows of numbers in it, 

allowing managers to incorporate this understanding into analysis and future planning. Benefits 

of charts and graphs also come into play in presentations, where they can be used to quickly 

illustrate trends in data for others to see. 

It's often easier to spot trends and patterns in graphs and charts than by simply looking through a 

long table of data, especially for big datasets, so one of the common uses of chart tools is in 

simply coming to grips with what a new dataset actually means. 

Automation of Chart Creation 

The Excel application automates the process of generating charts from existing data sets. If a 

spreadsheet already contains updated data, the chart function can transform this data into a chart 

with a minimal amount of user input. The Recommended Charts tool in Excel is a key part of this 

process. Using the chart function, spreadsheet administrators can generate a chart in a few clicks, 

choosing a chart type, as well as options such as labels, axes and titles. 

This is often a big advantage over drawing a chart by hand with an illustration tool or even using 

a more complex visualization tool, many of which require programming or configuration. 

Customization of Charts in Excel 

The chart function in Excel enables users to strike a balance between automation and 

customization. Although the program can generate a chart quickly and easily, the user is also able 

to assert control over many chart details if necessary. As well as customizing the data presented 

within a chart, users can finely tweak the chart options to any detail. Charts in Excel can also be 

altered after they have been initially generated, by selecting a chart and choosing from the 

available options to amend the chart type, data or other details. 
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Integration into Existing Sheets 

If a business or other organization is using spreadsheet data managed within Excel, using the 

chart function within Excel aids integration of the data. For example, when an Excel spreadsheet 

generates a chart from the data within a worksheet, the chart will automatically update whenever 

the data itself is edited. This allows business managers and administrators to manage their data 

and visualizations within a single application, with the results updating instantly. Excel 

spreadsheets can also be easily shared between users and computers. 

This can be one of the advantages of Excel tables and charts over other data visualization systems 
where charts and datasets are effectively stored and managed separately. 
 

Working with graphics in excel 

Definition: - In Microsoft Excel, a chart is often called a graph. ... A chart is a powerful tool that 

allows you to visually display data in a variety of different chart formats such as Bar, Column, 

Pie, Line, Area, Doughnut, Scatter, Surface, or Radar charts. 

Excel provides several features that make inserting graphics into your worksheet a breeze. 

However, once your graphic is in place, you may wonder how to format it. The following articles 

explore the many ways you can edit graphics in Excel. 

 

 Adding a Drop Shadow to a Text Box 

One way to make your text boxes "stand off" the page is to add a drop shadow to them. This tip 
shows just how easy it is to add this formatting touch. 

Adding Auto Shapes 

The graphics features of Excel allow you to add a number of predefined AutoShapes to a 
workbook. If you want to add shapes to the AutoShapes feature, however, you are out of luck. 
The shapes are apparently hard-coded into Excel, and cannot be modified. There are 
workarounds, however, and they are covered here. 

 Adding Data Labels to Your Chart 

Adding labels to a chart can make the information presented in the chart more understandable. 
Excel allows you to add different types of data labels to your charts, as discussed in this tip. 

 Adding Drop Shadows  

Want your shapes to really "pop" off the page? Add a drop shadow to them, as described in this 
tip. 

 Adding Text to an AutoShape 

You can add text to all sorts of drawing shapes, not just text boxes. Here's how easy it is. 
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 Adjusting Picture Appearance 

Excel provides the Picture toolbar to help you modify any images in your worksheet. This tip 
explains how to use the toolbar to adjust the appearance of a graphic. 

Assigning Macros to Graphics 

The graphics you place in a worksheet can do more than just look pretty. You can also assign 
macros to a graphic, which are triggered when the graphic is later clicked. 

Capturing a Screen 

A picture is worth a thousand words, but getting the picture—particularly a screen shot—into a 
workbook may seem daunting. Here's a couple of easy ways to get the picture you need. 

Changing an AutoShape 

Need to change a shape you previously added to your worksheet? It's easy to do using the 
graphics tools provided by Excel. Here's how. 

Changing Chart Types 

Want to change an existing bar chart to a different type of chart, such as a line chart or a column 
chart? It's easy to do when you follow the steps in this tip. 

Changing How Arrows Look 

If you use Excel's graphic capabilities to insert a line or an arrow into a worksheet, you can 
change how that arrow looks. For instance, you can change the type of arrowhead used and the 
ends of the line on which those arrowheads appear. 

Changing Line Color in a Drawing Object 

Don't like the color of the lines that Excel chose for your drawing object? It's easy to choose your 
own colors, as pointed out in this tip. 

Changing the Axis Scale 

When creating a chart, you may want to adjust the default scaling that Excel applies to an axis. 
This is relatively easy to do by following the steps outlined in this tip. 

Changing the Pattern Used in a Data Series 

When you create a chart, Excel attempts to assign colors to your data series that it thinks will 
work best for you. If you want to change those colors to something else—including a variety of 
patterns—you can easily do so. 

Changing the Size of a Drawing Object 

Add a drawing object to your worksheet, and at some point you may want to change that object's 
size. You can easily change sizes by using the technique described in this tip. 

Changing the Size of a Graphic 

Adding a graphic to a worksheet is easy. Getting that graphic to just the right size may take a 
little bit of trial and error. Here's how to adjust the size easily. 



M.A. English Sem. 1st  Unit -3rd Computer Applications  ENG-VIII 

 

GCW, Narnaul  Page 26 

 

Colorizing Charts 

Need to change the color of different parts of your chart? It's easy to do when you apply the 
technique described in this tip. 

Controlling Display of the Scroll Bars 

The scroll bars can be very handy in navigating your worksheet, but did you know you can turn 
them off or on at will? Here's how. 

Controlling Display of the Status Bar 

Turning off the status bar through the options menu. 

Creating a Drawing Object 

Creating simple drawing objects is easy in Excel. All you need to do is use the tools made 
available on the Drawing toolbar. 

Creating a Log/Log Chart 

If you need to create a chart that uses logarithmic values on both axes, it can be confusing how to 
get what you want. This tip explains which of the chart types in Excel is best suited for the type 
of chart you need. 

Creating an AutoShape 

Ever wanted to create a simple drawing in your worksheet? Excel has made this simple. This tip 
explains how Excel uses AutoShapes. 

Creating an Organization Chart 

The graphics capabilities of Excel are flexible enough that you can use the program to create 
organization charts. Here's how quick overview of how easy creating such a chart can be. 

Creating Custom Chart Formats 

Excel allows you to create custom chart formats that go beyond the standard formats provided in 
the program. You can then apply the custom chart format to future chart-creating endeavors. 
Here's how to create and save your custom chart formats. 

 

Using worksheet as database in accounting 

Microsoft Office Excel was designed to support accounting functions such as budgeting, 
preparing financial statements and creating balance sheets. It integrates with external data to 
allow you to import and export banking information and financial data to and from 
other accounting software platforms. 

Definition: Worksheets are prepared at the end of an accounting period and usually include a list 
of accounts, account balances, adjustments to each account, and each account’s adjusted balance 
all sorted in financial statement order. As you can imagine, after a worksheet is completely filled 

https://excel.tips.net/T002643_Controlling_Display_of_the_Status_Bar.html
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out, preparing financial statements manually is quite simple. Most of the preparation work goes 
into drafting the worksheets. 

What Does Accounting Worksheet Mean? 

An accounting worksheet is a spreadsheet used to prepare accounting information and reports. 

Accounting worksheets are most often used in the accounting cycle process to draft an 

unadjusted trial balance, adjusting journal entries, adjusted trial balance, and financial 

statements. 

As with most working papers, accounting worksheets are designed for internal purposes only. 
External users like investors and creditors rarely if ever get to see a company’s accounting 
worksheet. This means that the worksheet format can be flexible. Companies can customize the 
format of their worksheets to fit their internal demands and work flow needs. 

Example 

Bookkeepers and accountants use accounting worksheets for a variety of reasons. Worksheets 
make transferring t-accounts into an adjusted trial balance much easier. Worksheets also reduce 
the risk of errors making errors when producing financial statements. Worksheets can also be 
used for planning purposes. Since the worksheets are used to make adjusting journal entries, 
managers can examine the worksheets before the adjustments are posted to see their effect on the 
overall financial statements. Worksheets can also be helpful in preparing interim financial 
statements. 

Microsoft Office Excel was designed to support accounting functions such as budgeting, 

preparing financial statements and creating balance sheets. It comes with basic spreadsheet 

functionality and many functions for performing complex mathematical calculations. It also 

supports many add-ons for activities such as modeling and financial forecasting, and seamlessly 

integrates with external data to allow you to import and export banking information and financial 

data to and from other accounting software platforms. 

1. Accounting & Budget Software 

2. Accounting Tools for a Growing Company 

3. Can I Connect Quicken to Mint? 

4. Apply the Default Accounting Formula in Excel 

 

Microsoft Office Excel was designed to support accounting functions such as budgeting, 

preparing financial statements and creating balance sheets. It integrates with external data to 

allow you to import and export banking information and financial data to and from other 

accounting software platforms. 

 

https://www.myaccountingcourse.com/accounting-dictionary/financial-statements
https://www.myaccountingcourse.com/accounting-dictionary/financial-statements
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Budgeting and Statements 

Microsoft Office Excel ships with templates for creating budgets, cash-flow statements and 

profit-and-loss statements, which are some of the most basic documents used in accounting. In 

addition, you can download more complex budgeting and statement templates from the Office 

website, or purchase specialized templates from third-party vendors and install these in the 

application. If you need to create complex or custom budgets or financial statements, you can 

either customize an existing template and re-use its elements, or create one from scratch using 

the functionality built into Excel. 

Spreadsheets 

Performing line calculations is a basic accounting task, and Excel spreadsheets are designed to 

contain data in a tabular format that supports both in-line and summation calculations, replacing 

the need for ticker tape and special accounting calculators. The data in the spreadsheet is 

reusable and storable, making Excel more flexible than an accounting calculator for performing 

simple calculations and summations. Additionally, you can create charts and graphs from the 

spreadsheet data, creating a media-rich user experience and different views of the same data. 

You can also use add-ons to mine the data and create models and financial forecasts. 

External Data 

You can import data from many different data sources into Excel. This is especially useful for 

accounting as you can pull sales data, banking data and invoices from many sources into one 

central workbook to support your accounting activities. The data can be stored in different 

databases and file formats prior to importing, allowing you to access data from many different 

areas of your business without having to do additional data entry. 

Integration 

Excel integrates with many popular accounting software applications. For example, you can use 

the wizards that ship with your preferred accounting software package to map Excel spreadsheets 

to your accounting data so you can perform push and pull data operations from both Excel and 

your accounting package on demand. 

Working with Excel in marketing  

It is a common thing for businesses to use Microsoft Excel, which is a spreadsheet application 
installed as a default component of the MS Office suite. You can use individual worksheets in 
Excel workbooks to create spreadsheets and lists. The application has any powerful tools at your 
disposal which can be used in the field of marketing and business promotion. There are a few 
functions related to business that you can perform on Excel. 

• Scheduling 

Basic employee and resource schedules are created by businesses using Excel and these 
schedules can be designed to automatically update any change in schedule as well as be color 
coded for the purpose of highlighting. You can create schedules for a weekly basis with the days 
of the weeks in the columns and with the rows containing the work hours or work shifts. You can 
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fill in each slot with the resource name or employee name for a given day. By doing this all 
departments can work from the same resource sheet so that everyone comes to know of the given 
resource is available for them to use.  
 

• Product Sales 

You can track product sales on a daily, weekly, monthly or quarterly basis by using Excel. You 
can collect the sales data on an Excel spreadsheet and compare the progress over time as well as 
identify downward or upward trends as they happen. Once you have a substantial and 
meaningful amount of sales data tracked into Excel, you can predict sales for the next year which 
is a great thing for business as it lets you make significant plans for the future. 

• Basic Accounting 

Excel is used often by small businesses as a checkbook ledger or as a basic accounting program.  
Deposits and expenditures can be entered on each row of the spreadsheet as you would enter 
them on a into a check register. The most beneficial thing about using Excel in this fashion is 
that you can compare business income and expenditure over time by looking at the data 
collected. 

•  Customer Data 
In Excel, often the inclination to create ad hog lists translates into creating a full fledged 
customer database. When you use Excel to gather and track data, the databases do not have to be 
planned out in full. This is why Excel is ideal for storing customer information that grows in 
detail over time because there is the benefit of adding more fields without disturbing the existing 
data.  

• Investment Returns 

You can track total business sales along with total advertising and marketing expenditures in 
Excel and in this way, you can track your return on investment for each campaign. In case you 
are tracking the sales, you will be able to see how long it takes you to reach targeted profit levels 
or exceed this level from an ad campaign. 

Working with Excel in Finance  

 

Imprint this in your mind. If you are in the finance industry, Microsoft Excel will be your best 
analytical tool till the end of your career. Conduct of financial analysis in Excel is a given thing. 
You will be dealing with a lot of finance Excel spreadsheets from the first day of your career. 

The Excel is an invaluable source of the financial data analysis. Every day, an uncountable 
amount of financial data is analyzed by financial experts. These data helps investors to improve 
investment portfolios and dig deeper into the financial market. 

You will be working on huge data sets, large financial models and that too, within strict 
deadlines. Therefore, it is important to know how to use excel efficiently and effectively. Excel 
usage and management is essential. 
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By efficiency, it means that you should be able to use the right shortcuts. By effectively, it means 
that you should learn to conduct the right excel operations. By management, it means you should 
be able to manage an endless number of excel files properly. 

Why it is important to know shortcuts is because they are not only time savers but there is one 
more benefit to it which I am sure all of us will agree. When you are working for long hours and 
under pressure, imagine yourself using the computer or laptop mouse for around 10-12 hours 
continuously! If nothing else, this act itself will cause you a lot of stress. Believe me; it causes a 
lot of pain in every sense! 

So, why not do away with mouse usage by learning these extremely handy and easy to use 
keyboard shortcuts? 

Importance of Financial Analysis using Excel 

We have split this program into three broad categories: 

(1)   Data Manipulation & Navigation 

(2)   Formatting 

(3)   Formulas & Advanced Topics 

By Manipulation, we mean how you can insert or delete rows or columns in excel, how you can 
hide, unhide, group, ungroup your data and more. 

By Navigation, we mean how you can move around your workbook and worksheets more 
efficiently. 

By Formatting, we tell you ways to make your data more presentable. It tells you ways to 
change the background color, font size, color, and other presentation factors. 

Right now you will find it quite silly, but believe me; you require all these things when you work 
in investment banks, equity research, and financial research. It is, thus, very important that you 
have good command over all the relevant shortcuts. 

By Formulas, we imply the active role calculations play in the Excel program. In the Excel 
software, there are many built-in functions available. Again, we are not going to see all those 
functions. We are going to study the ones that are used most frequently in investment banking 
and finance. 

By Advanced Topics, we refer to some features like Lookup functions, Pivot Tables, Macros and 
all those functions that maximize our capability to perform financial functions with Excel. 
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These are some of the Excel features that are used frequently in investment banking, finance and 
consulting. 

Excel for Finance 

Though we will be covering most of the shortcuts that are used frequently in investment banking, 
financial analysis and consulting, I am not covering here all the shortcuts that are available in 
excel. Never forget to remember the 95-5 rule. 
 
I will focus only Excel 2003. 
 
The reason being that even today, most investment bankers use Excel 2003 and not 2007. I have 
used Excel 2003 as the base. However, most of the shortcuts are the same in Excel 2003 and 
2007. To learn more about shortcuts, take a look at this dedicated article.  I have mentioned the 
differences wherever applicable. Even if you have Excel 2007, there is nothing to worry. 
Finally, the last and most important point to note is to avoid using the computer or laptop mouse 
while using Excel. The main purpose of using Excel shortcuts is to cut down the mouse usage. It 
is impossible to learn everything about Excel because there are changes in every new version and 
you never know what kind of financial analysis you have to conduct. Therefore, take Excel 
learning as learning-in-progress. 

Endnote 

Using Excel is tough - do not remain under any illusion. It takes a lot of time to master the use of 
Excel. Further, the knowledge of Excel and its operative factors is essential for a career in the 
finance industry. 
Let’s start a journey towards learning excel for finance, investment banking and consulting. 
Begin the learning phase while you are still studying. It will reduce the learning curve as you 
seek out finance jobs and can easily surpass other candidates. Moreover, any interviewer, while 
hiring a potential candidate in the finance segment, looks for skills. Your knowledge of Excel is 
your skill. If you are prepared in advance and able to convey this skill to the interviewer, your 
chance of recruitment is better than others. 
  
    So the Excel application, with all its advanced technical features, allows you to use it as a 
database application for marketing and business promotion in a well rounded, efficient and 
hassle free way. 

 

Using worksheet as database in personnel area: 

Recruitment, training & development, compensation & benefits, payroll, employee relations, 

staff retention. HR professionals are often seemed to have the easiest jobs in the company. 

In reality, what goes behind the scenes are the endless amount of human resource information 

system (H.R.I.S.) inputs, preparing reports for the management, and spending face-time with 

employees just to get the day-to-day work done. 
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the majority of the Small and Medium Enterprises are not using any specialized software to track 

employee details but using Microsoft Excel. HR professionals are already so busy with their HR 

work. But without investing time to learn Excel, they often are not aware of the magic that Excel 

can bring into their work. 

Many times, HR professionals are required to calculate dates with reference to today’s date. Age 

of employee, length of service, etc. are all referenced to today’s date. The function TODAY 

recalculates itself so that you will always have today’s date in formulas. 

To find out the difference between 2 dates, let me introduce you to the function DATEDIF. 

EDATE helps you to set future dates based on the number of months. 

Often we may need to figure out the number of working days between two dates. At this time, 

many HR professionals will be taking out their desktop calendars and counting the days. 

1, 2, 3, … someone interrupted them and they start from 1 again. If you are using Excel 
versions, NETWORKDAYS.INTL is here for the rescue! 

Many times HR will be required to produce monthly reports. And preparing reports can typically 

take quite a long time. We will go through 2 functions, COUNTIF and SUMIF that will speed up 

your reporting from days and hours to mere minutes! 

Major Disadvantages of Using Spreadsheets for HR 

1) Poor built-in controls 

There are no controls to restrict employees using the spreadsheet from making changes. There is 

nothing like can-be-accessed-only-by-managers in a spreadsheet. Yes, you can password protect 

a spreadsheet, but you cannot control what to show and what not to show to other viewers. All 

one needs is a computer and any kind of information shared with that person on the spreadsheet 

can be altered, thus making the information less trustworthy. 

2) Fraudulent entries 

There is a high risk of deliberately falsified entries being made due to poor quality control on 

vital data and lack of stringent regulations regarding the use. There may be times when managers 

are hand-in-glove with their subordinates, and if managers have access to the HR’s Spreadsheets, 

they could modify records for the benefit of certain individuals. What’s worse, the errors can be 

easily disguised and hidden without getting noticed at all. In cases of integrity breach, correct 

values maybe intentionally replaced with false values. 

3) Prone to human errors 

When a spreadsheet is handled by numerous people in the HR team or outside it, mistakes are 

bound to happen, as distraction, interference or simply, overlooking cannot be ruled out. They 

may or may not be intentional, but errors while feeding, modifying, replacing or deleting HR 

data surely results in erroneous outputs. 

4) Not adaptable for agile businesses 

Whether it is a startup or a well-established business, employees come and go. Spreadsheets are 

usually created by individuals and thus tend to contain terms or codes identifiable by that 
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individual only. So for instance, if a new HR manager is employed, she may not understand the 

terms or codes used by the previous HR manager and thus has to again modify the sheet 

according to her understanding and start from scratch. 

5) Consolidation woes 

Not all is done by merely keeping your data up-to-date in the spreadsheet. The main task comes 

when it’s time to generate HR or MIS reports based on that data. Owing to the fact that data in 

the spreadsheets is scattered throughout the organization and different locations, one has to go 

through a complicated consolidation process. End users from various departments would have to 

collect and summarize data from different spreadsheets and then submit it to the department 

heads, who then review, re-summarize, and submit the same to their seniors and so on and so 

forth till it reaches the decision making authority. In this whole process, the data is susceptible to 

errors, incorrect cell entries, copy-pasting errors etc. This method is extremely time-consuming 

and compromises on data integrity. 

6) Not scalable 

As an organization grows so does the data. It becomes increasingly impossible for an HR 

manager to handle such huge databases manually without considerable errors, unless he has 

another helping hand, but which again increases the risk of errors or misinterpretation of data. 

7) Hinders quick decision making 

Due to the consolidation woes, extracting data, processing information, preparing reports and 

making analysis is time-consuming and not the “ideal” path to quick decision making. It 

basically becomes a long drawn process involving multiple individuals and teams. Before even 

reaching any decision making stage, the data itself has to pass through so many layers before 

appearing before decision makers. 

8) Interruption in work 

The HR manager has to keep track of everything right from the recruitment process to harmony 

among employees. Due to the dynamic nature of data, the person using the spreadsheet to 

maintain records is constantly interrupted to make immediate changes as and when they happen 

and keep employee details up-to-date. This constant interference delays other work at hand and 

compromises its quality and accuracy. 

9) Time spent answering employee questions 

When employee details such as payroll, attendance, leaves, compensations, benefits etc are 

stored in spreadsheets, every time anyone needs an update, the HR personnel has to look-up huge 

data files and answer their queries as and when required. It takes up a big chunk of productive 

time which could otherwise be used effectively on more important tasks. 

10) Duplicate entries 

Spreadsheets have no means of highlighting duplicate entries and thus these duplicate entries 

lead to erroneous spreadsheets and misinterpretation of data. Yes you can definitely remove 

duplicate entries from a column or row, but that too doesn’t happen automatically. It takes 

intermediate level knowledge of using spreadsheets. 
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11) No Audit trails 

Audit trails represent any changes made to the document by allowing tracking thus detecting 

erroneous changes. This aids in preserving the integrity of data. Audit trails help identify what 

changes were made by whom and make it easier for an HR manager to accept genuine changes 

made by other contributors to the process. Most major spreadsheet programs, however, do not 

support audit trails but simply update new information entered, as is. Thus, leaving absolutely no 

proof of who worked on which area merely by a glance at it. It may tell you when the edit was 

made, but does not save its history. 
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Definition: - Power Point is a Microsoft presentation program that creates a slide show of important 

information, charts, and images to display during a presentation. It is most often used for business 

and school presentations. 

Benefits of Power Point 

Power Point provides multiple benefits to users, including: 

• It is widely used, and considered the "standard" for presentation software. If you create a Power 

Point presentation, it's more likely it will be easier for others to open and view. 

• It includes many optional presentation features, including slide transitions, animations, layouts, 

templates, and more. 

• It offers the option to export its slides to alternative file formats, 

including GIF and JPG images, MPEG-4 video, PDF, RTF (rich text format), WMV (Windows 

Media Video), and Power Point XML. 

The Ribbon in Power Point 

 

 

 

 

 

 

Once you get used to it, you'll find the Ribbon is far easier to use than the file menu interface used in 

previous versions of word. By default the Ribbon in Power Point is divided into seven tabs, with an 

optional eighth tab (Developer) 

They are: 

 

• Home: This contains commonly used Power Point features, such as creating new slides, changing 

layouts, deleting slides, formatting text and paragraphs, inserting shapes, and creating drawings. 

• Insert: As you might guess, this one handles anything you might want to insert into a 

presentation, such as pictures, clip art, charts, tables, movies, audio clips, photo albums (a new 

feature), headers and footers, text boxes, WordArt ... etc. 

• Design: From this tab you can apply different themes to your presentation; change colours, fonts 

and effects; select background styles; change the slide orientation and page setup...etc. 

• Animations: A more accurate name for this tab might be transitions, because it lets you control 

the animations used as transitions between slides. Creating transitions is now very easy, just move 

your mouse cursor over an icon of a particular transition on this tab and you'll see a live preview 

of that transition. Click on that transition and you have added it to your slide. On this tab you can 

also create custom animations, change transition sounds and speeds, and make other changes to 

animations. 

• Slide Show: On this tab you can do anything you need to with your slide show -- preview it, 

create a custom slide show, change the set up or rehearse your narration and timings. 

https://www.computerhope.com/comp/msoft.htm
https://www.computerhope.com/jargon/p/program.htm
https://www.computerhope.com/jargon/e/export.htm
https://www.computerhope.com/jargon/g/gif.htm
https://www.computerhope.com/jargon/j/jpeg.htm
https://www.computerhope.com/jargon/m/mpeg4.htm
https://www.computerhope.com/jargon/p/pdf.htm
https://www.computerhope.com/jargon/r/rtf.htm
https://www.computerhope.com/jargon/w/wmv.htm
https://www.computerhope.com/jargon/x/xml.htm
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• Review: To check spelling and grammar use the thesaurus, track changes, review other people's 

changes or compare documents? This is the tab to use. 

• View: This tab allows you change the view in any way, including changing presentation views -- 

such as slide master, handout master, notes master and slide sorter. You can also show or hide a 

ruler and gridlines; zoom in and out; choose from colour, gray scale, or black and white; and 

display windows as either split or cascaded. 

• Developer: To display this tab, click the Office Button > Power Point Options > Popular > 

Show Developer tab in the Ribbon. Most users will only need this tab to record Macros but it 

also lets you insert controls such as buttons and text boxes, if you have written your own code for 

them. 

New features in Power Point 2007 

The new look of Power Point is not the only change to the application, there are plenty of new 

features as well. 

No Right Hand Pane 

In Power Point 2007, the right-hand pane from previous versions has been banished; its functions 

have been replaced by the Ribbon. When you create a new slide and want to apply a new layout to 

it, you now use the Design group in the Ribbon. 

Themes 

As in all of the Office 2007 applications, Themes have been introduced to allow users to quickly 

apply common colours, backgrounds and fonts to all elements of a presentation for a unified look. 

In previous Power Point versions, you had to make those changes separately for charts, tables and 

slides. 

To apply a theme to a presentation, click the Design tab and move your mouse cursor over each 
theme to preview them, when you find a theme you like, click it to keep it. 

Shown below is the same slide in a show shown with different themes selected for it. 

Office theme Concourse theme 

Be aware that Themes only work if you're using Power Point's new Office XML format; they won't 

work on old-style .ppt files. 

Custom Slide Layouts 

From the View tab > Slide Master, you can now create and save custom layouts for your 
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presentations, including charts, movies, tables, pictures, Smart Art, clip art and other elements. You 

can also create and save multiple slide master sets that contain tailored layouts for different topics. 

Smart Art 

In Office 2007, you get far better prebuilt diagrams and charts via Smart Art. Choose the Insert 

tab, > Smart Art, and you'll be able to insert a wide variety of diagrams and charts, as you can see 

in the figure below. Click any of the available diagrams or charts, and you'll get a description of 

what it's best used for and how to use it. Smart Art offers many new types of diagrams and charts. 

 

 

In addition, you can add a variety of effects, such as gradients and 3-D, to Smart Art and other 

Power Point graphics. You can also convert existing content to Smart Art, by right- clicking (on a 

bulleted list or similar) and selecting Convert to Smart Art you will be able to port the list into a 

prebuilt Smart Art template. 
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Better Multimedia Integration 

It's now easier to incorporate multimedia into your presentations. On the Insert tab, choose either 

Movie or Sound from the Media Clips group, and insert your multimedia object. From here, you 

can also play a CD audio track during the presentation. And you can even record audio directly 

from within Power Point and embed it in your presentation. 

New effects 

There are a host of new and better effects in Power Point 2007, including warp, bevel, shadow, 

reflection, soft edges and rotating 3-D shapes. You can get to these effects in a variety of ways, 

depending upon where you're using the effect. 

If you want to use an effect on a picture, put your cursor on the picture, select the Format tab > 

Picture Tools (this appears only when you've selected a picture). > Picture Effects drop-down 

list, select the effect you want to use. 

 

Discontinuous text selection 

This change is an example of a very small change that can save lots of time. You can now select 

multiple pieces of discontinuous text and then make changes to them. This works the same way as 

it does in Word, hold down the Ctrl key as you select your text, and then apply changes to all the 

text simultaneously. 
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Some More Basic Power Point Features 

Power Point is the presentation software of the Microsoft Office software suite. One of the most 

widely used office programs; Power Point has applications for personal use, academics and 

business. It is highly customizable; you can edit Power Point presentations to be as personal or 

professional as you want. Power Point has a relatively simple user interface which you can easily 

pick up. However, mastering each of its functions will allow you to create impressive presentations 

Design 

The design features of Power Point allow you to customize the appearance and format of the slides. 

Power Point typically comes with a set of preloaded themes for you to choose from. These can 

range from simple color changes to complete format layouts with accompanying font text. Themes 

can be applied through the whole presentation or a single slide. Using the page setup allows you to 

optimize the presentation for the display size; for instance, you should use a larger screen ratio 

when displaying on a projector compared to a computer screen. 

Animation 

Power Point animation is divided between slide transitions and element animation. Using slide 

transition adds an effect when switching slides during a slide show. You can edit the transition 

effect and timing, as well as opt for an on-click or automatic transition between slides. Element 

animation adds movement and sounds to the objects within the slide. For example, if you're 

constructing a photo gallery as a slide show, you can choose which pictures enter the slide first, how 

they enter and add a sound as they enter. 

Presentation 

The presentation function of Power Point is largely designed to accommodate public speaking. 

Power Point comes with a built-in notes function; when printing out presentation slides, you can 

add presenter notes beside each slide as accompanying content. This is useful to clarify points in the 

slide without sacrificing the slide's readability. As of the 2007 version of Power Point, you can pre-

record narration for a presentation. Power Point also has a rehearsal function as well, allowing you 

or your team to practice your timing and monitor the length of your presentation. 

Integration 

Power Point is compatible with all other software in the Microsoft Office suite; you can export 

slides into Word documents or use Excel charts within your presentation. In addition to image and 

audio support, Power Point 2007 also has video-integration functionality; you can embed videos 

within a presentation for easy playback without exiting the program. You can also export 

presentation files to an online interface for multi-user remote editing and presentation practice. 

 

Creating a Power Point Presentations using Easy Way 

Step 1: 

Open Microsoft Power Point. 

 

Step 2: 

Go to File at the top of the screen and click New. A box that says “New Presentation” should 
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appear on the right side of your screen. 

 

Step 3: 

In the “New Presentation” dialog box, click on “From Design Template.” You may then scan 

through design templates and choose one that you like. 

 

 

Step 4: Slide Design 

Select a design template by clicking on the template you like. You may choose a different color for 

your template by clicking on “Color Schemes” in the “New Presentation” dialog box. 

 

Step 5: Slide Layout 

Change the Slide Layout. You may change the slide layout (how information is presented in the 

slide) by going to the top of the screen and clicking on “Format” – “Slide Layout.” A box will 

appear on the right side of your screen (where “New Presentation” appeared) labeled “Slide 

Layout.” You may select a design by clicking on it. 

 

Step 6: Adding Text 

Enter your text by clicking and then typing in the box titled “Click to Add Text” or “Click to Add 

Title.” 
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Step 7: Adding Pictures 

You may add pictures by clicking on the box that says “Click to add content.” Inside that box, there 

will be a smaller box with six icons. Click on the icon that looks like a photograph of a mountain. A 

new window will open, allowing you to browse for a picture on your computer or a CD. Once you 

find your picture, click on it and then click “Insert.” 
 

Step 8: Resizing Pictures 

You may change the size of your picture by clicking on the picture. The picture will then have 

black lines around it with small bubbles or boxes in the corners. Place your mouse over the bubbles 

or boxes and click. Holding the mouse pointer down, drag the picture to the size you want. 
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Step 9: Now You are Done  

Now you completely have done your Presentation using nine steps.  

 

Working with graphics in Power Point  

A graphic in Power Point as any image that is not a picture. This includes Smart Art, which is 

a type of native Power Point graphic and has special attributes. A Power Point 

graphic most typically refers to a grouping of shapes into an image commonly referred to as 

vectors.  

Working with various types of graphics in Microsoft Power Point. A design ‘rule of thumb’ is to 

include some sort of graphic on at least every third slide to aid in keeping the audience interested 

and focused. 

Inserting Clip Art 

A gallery of clip art is available both within Power Point as well as on the Microsoft website. These 

graphics are free for use in Microsoft products. 

 

Sound design theory recommends using clip art judiciously; it should not be used as space filler. 

Clip art was innovative a decade ago; now it is old news. 

1. To insert clip art, go to the Insert tab and click Clip Art. 

2. This brings up the Clip Art pane on the right side of the screen. 

3. Enter a keyword and click Go to begin your search. 

 

a. You may limit the type of clip art for which you are searching – clip art, photographs, 

movies, or sound. 
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Click on the clip art to insert it into 

your presentation. 

 
 

b. To insert the graphic into your presentation, simply click on it. 

 

 

4. If you are connected to the Internet, you can also search Office Online for additional clip art. 

In the Clip Art pane on the right side of the window, click Clip art on Office Online. This 

opens up Microsoft Office Online in a browser, and you can now search for additional clip art 

to download. 
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Inserting Pictures 

You can also insert pictures that you have stored (for example, a photograph from a digital camera 

or a scanned image). 

1. To insert a picture, go to the Insert tab and click Picture. 

 

 

 

 

 

 

2. Browse for the location of your picture. Select it and then click Insert. 
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Working with Clip Art and Pictures 

When clip art and pictures are selected, additional Picture Tools are available. 

 

 

 

 

 

 

1. The Compress Pictures feature is a helpful tool to reduce the size of the presentation. 

2. The features available in the Picture Styles group provide tools for enhancing your 

graphic. 

3. The features available in the Arrange group allow you to select how you want to align, 

group, rotate, or layer the graphic. 

4. The features available in the Size group allow you to crop a graphic as well to specifically 

indicate its height and width. 

5. If these Picture Tools are not available, check to make sure the graphic is selected. 

6. Microsoft Power Point was not designed to be an image editor. If significant alterations to 

a graphic are necessary, you should use dedicated image software, like Photoshop. 

 

Drawing Shapes 

Microsoft Power Point comes with a variety of shapes, lines, arrows, callouts, and more that can be 

drawn in your presentation. 

1. To draw a shape, go to the Insert tab and click Shapes. 

 

 

 

 

 

2. Select a shape. 
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3. Move your mouse where you would like to draw the object, and while holding down the 

mouse button, draw the shape. The pointer will look like a plus sign (+) while drawing 

shapes. 

4. Shapes can be moved by clicking and dragging. 

5. When the shape is selected, additional features are available on the Drawing Tools tab. 
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Inserting WordArt 

WordArt is a gallery of text styles that you can add to your presentation to create decorative effects, 

such as shadowed or mirrored (reflected) text. You can also convert existing text into WordArt. 

1. To insert WordArt, go to the Insert tab and click WordArt. 

 

 

 

 

 

 

 

2. From the gallery, select the style of WordArt you wish to use. 

 

3. Type the text into the placeholder. 

4. WordArt can be moved by clicking and dragging, just as any other graphic. 

5. When WordArt is selected, an additional Drawing Tools tab is available with formatting 

utilities to adjust the style, color, outline, and effect.  Many of the effects are new to 

Office 2007, including reflection and 3-D rotation effects. 
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Inserting Smart Art 

Smart Art, a visual representation of your message, is new to Office 2007. Smart Art allows you to 

create editable illustrations simply and without the aid of a professional designer. You can easily 

create dynamic workflow, relationship, or hierarchy diagrams. 

1. To insert Smart Art, go to the Insert tab and click Smart Art. 

 

 

 

 

 

 

2. From the gallery, select the style of Smart Art you wish to add and click OK. The styles are 

organized into categories, from which you can browse via the list on the left. Or you can 

browse through all the styles by selecting the all category on the left. You will be able to 

customize the Smart Art in the next step. 

 

 

3. Once you have selected the Smart Art style, you can begin customizing the graphic to meet 

your needs. 

a. Click on the text placeholders to enter text. 

b. Use the features available on the Design tab to add shapes, rearrange the shapes, 

adjust the layout, change colors, change the style, or reset the graphic to its original 

look. 
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c. Use the features on the Format tab to adjust the formatting of the shapes. 

 

 

 

 

 

 

 

 

 

Show time and Rehearse timing in power point 

The scheduled or actual time at which a show of slides or linking of slides begins within a 

specific time this is set for them. 

Rehearse timing is a feature which allows one to record the time of slide preparation. It 

automatically records the time and presents the slides in the orderly manner and keeps them on 

screen for the set time. 

Rehearsing timings can be useful if you want to set up a presentation to play at a certain speed 

without having to click through the slides to present it. Think of it as a tool to help you practice 

presenting your slide show. Using this feature, you can save timings for each slide and 

animation. Power Point will then play back the presentation with the same timings when you 

present it. 

Rehearsing is often one of the last steps in creating a well-polished presentation. If you've never 

presented a slide show, you may want to review our lesson on Presenting Your Slide Show to 

become familiar with the basics. 

 

To rehearse timings: 

1. Select the Slide Show tab, and then locate the Set Up group. 

2. Click the Rehearse Timings command. You will be taken to a full-screen view of your 

presentation. 

https://edu.gcfglobal.org/en/powerpoint2013/presenting-your-slide-show/1/


M.A. English, 

Sem- 1st   
UNIT – 4TH, COMPUTER APPLICATIONS                                                         ENG-VIII 

 

Dr. Ashwini Bhardwaj 

GCW, Narnaul Page 16  

 

3. Practice presenting your slide show. When you are ready to move to the next slide, click 

the Next button on the Recording toolbar in the top-left corner. You also can also use the 

right arrow key. 

 

4. When you have reached the end of the show, a dialog box will appear with the total time of 

your presentation. 

 

 

5. If you are satisfied with your timings, click yes. 

 

If you need more than one try to get the timings just right, the Recording toolbar has options to 

let you take a break or start over on a slide. To pause the timer, click the pause button on the 

toolbar. No actions taken while the timer is paused will be included in the timings. To re-record 

the timings on the current slide, click the repeat button. 
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Recording your slide show 

 

The Record Slide Show feature is similar to the Rehearse Timings feature, but it's a bit more 

comprehensive. If you have a microphone for your computer, you can even record 

voiceover narration for the entire presentation. This is useful if you plan on using your slide 

show for a self-running presentation or a video. Your mouse won't show up on screen in 

recorded slide shows, so if you want to point out details on screen you can use Power 

Point's laser pointer option. 

 

To record a slide show: 

1. Click the Slide Show tab, then locate the Set Up group. 

2. Click the Record Slide Show drop-down arrow. Select either Start Recording from 

Beginning or Start Recording from Current Slide. 

 

 

3. A dialog box will appear. Select the desired options. Remember, you can only record 

narration if you have a microphone attached to your computer. 



M.A. English, 

Sem- 1st   
UNIT – 4TH, COMPUTER APPLICATIONS                                                         ENG-VIII 

 

Dr. Ashwini Bhardwaj 

GCW, Narnaul Page 18  

 

4. Click Start Recording. Your presentation will open to a full screen. 

5. Perform your slide show. Make sure to speak clearly into the microphone if you are 

recording narration. When you are ready to move to the next slide, click the Next button on 

the Recording toolbar in the top-left corner or use the right arrow key. 

 

6. When you reach the end of the show, Power Point will close the full-screen view. 

7. Your slide show timings and narration are now included in your presentation. The slides 

with narration will be marked with a speaker icon in the bottom-right corner. 

 

 

To point out details during your recording, press and hold the Ctrl key and the left mouse 

button. Your cursor will show up as a laser pointer. Simply move your mouse to indicate the 
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desired details. Release the Ctrl key when you are finished pointing out things on screen. 

 

To remove narration or timings from a recorded slide show: 

 

1. Click the Slide Show tab, then locate the Set Up group. 

2. Click the Record Slide Show drop-down arrow. 

3. Hover the mouse over Clear, then select the desired option. 

 

 

Sharing presentation options 

 

Power Point offers several options to enhance or even totally change the way you deliver 

presentations. Instead of presenting your slide show normally, you can choose to present it as 
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a video, or even present it live online so others can view it remotely. No matter how you choose 

to give your presentation, you can enhance it by customizing your slide show to remove or 

reorder slides. All of these options can help you give a polished and professional presentation. 

 

Exporting a presentation as a video 

 

The Create a Video feature allows you to save your presentation as a video. This can be useful 

because it lets your viewers watch the presentation whenever they want. To make sure your 

viewers have enough time to view each slide, you might want to rehearse the timings 

or record your slide show before using this feature. 

 

To create a video: 

1. Click the File tab to access Backstage view. 

2. Select Export, then click Create a Video. Video export options will appear on the right. 

 

 

 

3. Click the drop-down arrow next to Computer and HD Displays to select the size and 

quality of your video. 
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4. Select the drop-down arrow next to Use Recorded Timings and Narrations. 

• Choose Don't Use Recorded Timings and Narrations if you don't have or don't want to 

use recorded timings. You can adjust the default Seconds to spend on each slide: in the 

box below the drop-down menu. 

• Choose Use Recorded Timings and Narrations if you have already recorded timings and 

narrations and want to use them in your video. 

 

5. Click Create Video. The Save As dialog box will appear. 

6. Select the location where you want to save the presentation, then enter a name for the 
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presentation. 

 

 

7. Click Save. As Power Point creates your video, a status bar will appear at the bottom of the 

Power Point window. When the bar is complete, your video is ready to view, send, or 

upload. 

 

 

In addition to emailing your video, you can upload your video to free video-sharing 

sites like YouTube. YouTube offers guides to creating an account and uploading videos. Once 

your video is uploaded, you can give the link to anyone you want to see it. 

http://youtube.com/
http://www.google.com/support/youtube/bin/answer.py?hl=en&answer=161805
http://www.google.com/support/youtube/bin/answer.py?hl=en&answer=57924
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Presenting your slide show online 

 

Presenting a slide show online is surprisingly easy. All you and your viewers need is an Internet 

connection—they don't even need Power Point. Once your viewers are connected, you can start 

the presentation as you normally would. 

 

Please note that you cannot edit your presentation or mark it with a highlighter or pen while you 

are presenting a slide show online. You also cannot use Power Point to speak to your audience. 

Plan to communicate with your viewers through teleconferencing, or pre-record your narration. 

To present online: 

1. Select the Slide Show tab, then locate the Start Slide Show group. 

2. Click the Present Online command. 
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3. A dialog box will appear. Click Connect. A status message will appear as Power Point 

prepares your online presentation. 

 

4. A link will appear. If it's not already selected, select the link. 

5. Click Copy Link to make a copy of the link or Send in Email to send an email with the 

link to your viewers. 

6. Click Start Presentation. 
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7. Present the slide show as you normally would, using the mouse or keyboard to advance 

the slides. 

8. When you are finished, click End Online Presentation. 

 

9. A dialog box will appear to confirm that you want to end the presentation. Click End 

Online Presentation. 
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Customizing your slide show 

 

Sometimes you might want to hide a slide while still keeping it in your presentation. For 

instance, if you are presenting a slide show to more than one group of people, hiding or even 

rearranging certain slides could help you tailor your slide show to each group you present it to. 

You could also choose to create a shortened version of your slide show to present when you're 

short on time. The Custom Slide Show feature allows you to create and name different versions 

of your slide show with hidden or rearranged slides. 

To create a custom show: 

1. Select the Slide Show tab, then locate the Start Slide Show group. 

2. Click the Custom Slide Show command, then select Custom Shows. 

 

3. A dialog box will appear. Click New. 

 

4. The Define Custom Show dialog box will appear. Locate the Slide show name field, and 

type in a name for your custom show. 

5. In the Slides in presentation: area, check the box next to the slides you want to include 

in your custom show. 

6. Click Add to add the slides to the Slides in custom show: box. If necessary, use 

the up and down arrows to reorder the added slides. 
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7. Click OK. 

8. Select Close to exit or Show to view your custom show. 

 

9. To play the custom show at any time, click the Custom Slide Show command, then select 

the desired presentation from the drop-down menu. 
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Hiding slides 

 

Sometimes you may just need to hide a few slides without rearranging the entire slide show. You 

can hide slides by selecting the desired slide and then clicking the Hide Slide command on 

the Slide Show tab. To unhide a slide, simply click the Hide Slide command again. 

 

 

Challenge! 

1. Open an existing Power Point presentation. If you want, you can use our practice 

presentation. 

2. Use the Rehearse Timings feature to record slide and animation timings for the 

presentation. If you have a microphone attached to your computer, use the Record Slide 

Show feature. 

3. Create a custom slide show from your presentation. 

4. Create a video of your presentation. 

 

Animation effects in Power Point 
 

An animation effect is a special visual or sound effect added to a text or an object on a slide or 

chart. It is also possible to animate the text and the other objects using the buttons on the 

Animation Effects toolbar. 

 

https://media.gcflearnfree.org/ctassets/topics/235/PP2013_AdvancedOptions_Practice.pptx
https://media.gcflearnfree.org/ctassets/topics/235/PP2013_AdvancedOptions_Practice.pptx
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You can have organization charts appear or you can have the bullet points appearing one at a 

time. 

 

Manual Animation 

It is possible to automatically animate almost everything in your presentation. The problem with 

this is that you are tied to the timings of the slide show when you will probably need to have the 

flexibility to allow questions and comments. For this reason you should consider triggering some 

of the animation manually. 

 

• Right click the object, select Custom Animation. 

• Click on the Effects tab and choose the animation you want to use. 

• Now click on Timings and select Animate and the On Mouse click radio button. 

 

Action Button toolbar 

Slide Transitions (Process of Change) 

Slide Transitions are not technically animations because they do not involve movement of the 

individual items on a slide. A transition is how you get from one slide to another. The normal 

way to move from one slide to another is to jump to the next slide. There are over 50 types of 

slide transitions that can be used a transition happens whenever a presentation slide changes to 

the next slide. The first decision to make is whether the slide transitions will occur manually or 

automatically. With manual transitions the mouse button or a key on the keyboard must be 

pressed for the next slide to be displayed. Manual transitions are essential if there is a chance that 

someone might ask a question during the presentation. 

 

Shortcut Keys 

(Page Up) - Perform the previous animation or move to the previous slide. 

(Page Down) - Perform the next animation or move to the next slide. 

Options 

(Edit, new animation effects) - Disables the new animation effects. Presentations with the new 

animation effects will not look the same when opened in earlier versions of Power Point. 

Animating Text 

The most common reason for animating text is draw attention to it typically one paragraph at a 

time. One way to do this is to create an entrance effect for the text placeholder; then adjust the 

effect settings so that the entrance is applied one paragraph at a time. When you do this the slide 

will initially appear empty except for the title. 

Click the mouse once and the first line will appear. 

Click the mouse again for the next paragraph to appear. 

 

 



M.A. English, 

Sem- 1st   
UNIT – 4TH, COMPUTER APPLICATIONS                                                         ENG-VIII 

 

Dr. Ashwini Bhardwaj 

GCW, Narnaul Page 30  

Another approach is to use an emphasis instead of an entrance effect. This allows all the 

paragraphs to be displayed on the slide initially. When you click the mouse the emphasis will be 

on the relevant paragraph. In either case you must first add the effect for the text placeholder and 

then display the Effect Settings dialog box by clicking the down arrow next to the effect and 

selecting Effect Options. The Group text drop-down box on the Text Animation tab of the Effect 

Options dialog box controls how the paragraphs appear. 

Add Animations 

You can animate the objects on your Power Point slides. Power Point provides four types of 

animations: Entrance, Emphasis, Exit, and Motion Paths. An Entrance animation determines the 

manner in which an object appears on a slide; for example, an object can move onto a slide. An 

Emphasis animation does something to draw attention to an object; for example, the object can 

become larger. An Exit animation determines the manner in which an object leaves a slide; for 

example, an object can move off a slide. A Motion Paths animation determines how an object 

moves around a slide; for example, an object can move from left to right. 

After you add an animation, you can use the Custom Animation pane to modify it by choosing an 

effect. Choosing an effect enables you to define what starts the animation, its properties (such the 

direction from which an object moves onto the slide), and control the speed of the animation. In 

addition, you can have an animation start when you click the mouse, start along with the 

previous animation, or start at a specified time after the previous animation. 

If the Auto Preview box is checked on the Custom Animation pane, Power Point provides you 

with preview of your animation after you create it and each time you modify it. You can also use 

the Play button  on the Custom Animation pane to preview an animation. 

 

To choose an effect: 

1. Select the object you want to animate. 

2. Choose the Animations tab. 

3. Click the Custom Animation button . The Custom Animation pane  

appears. 

4. Click the Add Effect button . A menu appears. 

5. Choose the type of effect you want. A submenu appears. 

6. Click the effect you want. Power Point applies the effect. 

 

To modify an effect: 

1. Click the down arrow next to the Start field on the Custom Animations pane and then select 

the start method you want. 
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2. Click the down arrow next to the Property field on the Custom Animations pane and the 

select the property you want. The Property field might be labeled Direction, Size, or some 

other property. 

3. Click the down arrow next to the Speed field on the Custom Animations pane and then select 

the speed you want to apply to your animation. 

4. To preview the animation, click the Play button  on the Custom Animations pane. 

EXERCISE 1 

Add an Animation to a Slide 

 

1. Click Slide 2 on the Slides tab. 

2. Select "Start saving early." 

3. Choose the Animations tab. 

4. Click the Custom Animation button . The Custom Animation pane 

appears. 

5. Click the Add Effect button . A menu appears. 

6. Choose Entrance. A submenu appears. 

7. Click Fly In. Power Point applies the effect. If the Auto preview box is checked, Power Point 

automatically provides you with a preview of the animation. 
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Modify the Effect 

 

1. Click the down arrow next to the Start field and then select After Previous. 

2. Click the down arrow next to the Direction field and then select From Bottom. 

3. Click the down arrow next to the Speed field and then select Medium. 

Add Another Animation 

 

1. Select "Apply for financial aid." 

2. Click the Add Effect button . A menu appears. 

3. Choose Entrance. A submenu appears. 

4. Click Fly In. Power Point applies the effect. If the Auto preview box is checked, Power Point 

automatically provides you with a preview of the animation. 

Modify the Animation 
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1. Click the down arrow next to the Start field and then select After Previous. The Apply for 

Financial Aid field appears in the center of the Custom Animation pane. 

2. Click the down arrow next to the Apply for Financial Aid field and then click Timing. The 

Fly In dialog box appears. 

 

3. Type 0.05 in the Delay text box. 

4. Click OK. 

 

5. Click the down arrow next to the Direction field and then select From Bottom. 

6. Click the down arrow next to the Speed field and then select Medium. If the Auto preview 

box is checked, Power Point automatically provides you with a preview of the animation. 

You can click the Play button  on the Custom Animation pane at anytime to preview 

an animation. 

Add Transitions 

Transitions determine how your presentations move from one slide to the next. For example, a 

slide can move up onto the screen and replace the previous slide. Power Point provides several 

transition methods. You can add sound to a transition and you can control its speed. You can 

apply a transition to selected slides or to all of the slides in your presentation. 

A transition can occur when the presenter clicks the mouse or after the amount of time you 

specify. 
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To apply a transition to selected slides: 

1. On the Slides tab, hold down the Ctrl key and then click the slides to which you want to 

apply the transition. 

2. Choose the Animations tab. 

3. Click the More button  in the Transition to this Slide group. A menu of transitions appears. 

4. Click the transition you want to apply. Power Point applies the transition. As you roll your 

pointer over each transition, Power Point provides you with a live preview of the transition. 

To apply a transition to all slides: 

1. Choose the Animations tab. 

2. Click the More button  in the Transition to this Slide group. A menu of transitions appears. 

3. Click the transition you want to apply. As you roll your pointer over each transition, Power 

Point provides you with a live preview of the transition. 

4. Click the Apply to All button  in the Transition to This Slide group. 

To add a sound to a transition: 

1. Choose the Animations tab. 

2. Click the down arrow next to the Transition Sound field and then click the sound you want. 

As you roll your pointer over each sound, Power Point plays the sound. 

To set the speed of a transition: 

1. Choose the Animations tab. 

2. Click the down arrow next to the Transition Speed field and then click the speed you want. 

If you want the transition to occur after the presenter clicks the mouse, check the On Mouse 

Click check box. If you want a transition to occur after a specified period of time, check the 

Automatically After check box and then specify the amount of time you want to elapse before 

the transition occurs. The On Mouse Click check box and the Automatically After check box are 

both located on the Animations tab in the Transition to This Slide group. 

EXERCISE 2 

Add Transitions 

 



M.A. English, 

Sem- 1st   
UNIT – 4TH, COMPUTER APPLICATIONS                                                         ENG-VIII 

 

Dr. Ashwini Bhardwaj 

GCW, Narnaul Page 35  

1. Choose the Animations tab. 

2. Click the More button  in the Transition to this Slide group. A menu of transitions appears. 

s 

3. Click the Push Up transition. As you roll your pointer over each transition, Power Point 

provides you with a live preview of the transition. 

 

Use of sound and its effects in Power Point  

The main purpose of adding animation to any slide object is to draw the attention of the 

audience to some movement. Once you set an animation event, and set the speed of the 

animation, you may also want some sound to play along with the animation -- one aspect that 

you should always remember is that although you can add sound to an animation, it is not always 

necessary to do so. We suggest you only add sound sparingly -- and even then, you must make 

sure that the sound adds some value to the animation.  

Sound effects in PPT 

Power Point comes with sound files you can insert into your Power Point slides. Windows comes 

with some useful sounds, too. If you have access to the Web, you have access to an unlimited 

supply of sounds. Sound files consume large amounts of hard drive space. Even a few seconds of 

sound can take 100K or more. 

 

 

https://www.indezine.com/products/powerpoint/learn/animationsandtransitions/addingananimation.html
https://www.indezine.com/products/powerpoint/learn/animationsandtransitions/animationevents.html
https://www.indezine.com/products/powerpoint/learn/animationsandtransitions/animationspeed.html
https://www.indezine.com/products/powerpoint/learn/animationsandtransitions/animationspeed.html
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Power Point allows you to use two basic varieties of sound files: 

• Wave files: Wave files contain digitized recordings of real sounds. These sounds can be 

sound effects, such as cars screeching, guns firing, or drums rolling; music; or even 

quotes from movies or your favorite TV shows. 

• Wave files come in several formats: 

o WAV: Windows and Power Point come with a collection of WAV files that provide 

simple sound effects such as swooshes, blips, applause, and drum rolls. 

o MP3 and WMA: For longer sound clips, such as complete songs; the popular 

formats to use include MP3, a compressed format that is popular for sounds obtained 

from the Internet, and WMA, a newer audio format developed by Microsoft for newer 

versions of Windows. You can tell the format of a sound file by the filename’s 

extension (.MP3 or .WMA). 

• MIDI files: MIDI files contain music stored in a form that the sound card’s synthesizer 

can play. Windows comes with several MIDI files, and you can download many more 

from the Internet. MIDI files have the file extension .mid. 

You’re more likely to use wave files than MIDI files in a Power Point presentation. MIDI files 

are great for playing music, but the wave files enable you to add a wider variety of sounds to a 

presentation. 

How to add a sound to a presentation  

Adding sounds to your Power Point presentation represents a great chance to further engage your 

audience. In Microsoft Office 2007, the process has been streamlined, and you will find many 

important options in a contextual tab follow these steps to create a truly "multimedia" 

presentation, tactfully. 

Navigate to the "Insert" tab and select "Sound" from the "Media" grouping. To add a specific 

sound file, select to "Insert sound from file." 

Browse to where your file is located, and click "Ok" to drop the sound file onto the slide, in 

which you are working, as an object. 

Choose whether you would like the sound to play automatically, or to be started upon clicking on 

the sound object icon within your slide. 

Assess your options. You have inserted a sound into your presentation, but the choices as to how 

you present it are open to your whimsy and creativity. 
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• If you would like to change your choice of whether to play the sound automatically, or 

after a mouse click, access the drop down menu in the "Sound Tools - Options" 

contextual tab in the Ribbon. 

 

By default, Power Point 2007 leaves the sound object as a visible object in your slide. This can 

be toggled by clicking the box labeled "Hide during show," located in the "Sound Tools - 

Options" contextual tab. This will help you have a cleaner presentation when playing a sound 

automatically, but if you have selected to start the sound playback upon clicking the object (see 

Step 3), you will not be able to do so if you've elected to hide the object during the presentation. 

Increasing the file size limit for embedded sounds will absorb the sound file, if it is under the 

limit, into your presentation's single ".pptx" file. If the sound(s) you have included in your 

presentation are above the limit you specify, you will need to include the sound file(s) in the 

same location as your ".pptx" file, wherever you save it or share it (e.g., you would attach the 

".pptx" file and the accompanying ".mp3" file in email if you were to be sending your deck to a 

colleague). 

Add Sound and Set the Speed 

 

1. Click the down arrow next to the Transition Sound field and then click Click. 

2. Click the down arrow next to the Transition Speed field and then click Slow. 

Advance Slide 

 

1. Check the On Mouse Click check box. 

2. Click the Automatically After check box. 

3. Type 00:07 in the Automatically After text box. 

4. Click the Apply to All button . Power Point applies all of your changes to all 

of the slides. 

5. Click Slide 1 on the Slides tab. 

6. Type 00:03 in the Automatically After text box. Power Point changes the timing for Slide 1. 
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